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例子1 单透镜 (Singlet) 

 

1-1 单透镜 

这个例子是学习如何在 ZEMAX 里键入资料，包括设罝系统孔径(System Aperture)、透镜

单位(Lens Units)、以及波长范围(Wavelength Range)，并且进行优化。你也将使用到光线扇形图

(Ray Fan Plots)、弥散斑(Spot Diagrams)以及其它的分析工具来评估系统性能。 

 

这例子是一个焦距 100 mm、F/4 的单透镜镜头，材料为 BK7，并且使用轴上(On-Axis)的

可见光进行分析。首先在运行系统中开启 ZEMAX，默认的编辑视窗为透镜资料编辑器(Lens 

Data Editor, LDE)，在 LDE 可键入大多数的透镜参数，这些设罝的参数包括： 

 表面类型(Surf：Type)如标准球面、非球面、衍射光栅…等 

 曲率半径(Radius of Curvature) 

 表面厚度(Thickness)：与下一个表面之间的距离 

 材料类型(Glass)如玻璃、空气、塑胶…等：与下一个表面之间的材料 

 表面半高(Semi-Diameter)：决定透镜表面的尺寸大小 

上面几项是较常使用的参数，而在 LDE 后面的参数将搭配特殊的表面类型有不同的参数涵义。 

 

1-2 设罝系统孔径 

首先设罝系统孔径以及透镜单位，这两者的设罝皆在按钮列中的「GEN」按钮里

（System->General）。点击「GEN」或透过菜单的 System->General 来开启 General 的对话框。

S 

 



 

 

 

 

点击孔径标签(Aperture Tab)（默认即为孔径页）。因为我们要建立一个焦距 100 mm、F/4

的单透镜。所以需要直径为 25 mm 的入瞳(Entrance Pupil)，因此设罝： 

 Aperture Type：Entrance Pupil Diameter 

 Aperture Value：25 mm 

 

点击单位标签(Units Tab)，并确认透镜单位为 Millimeters。单击「确认」来离开对话框。 



 

 

 

 

1-3 设罝视场角 

点击按钮列中的「Fie」或透过菜单的 System->Filed 来开启场对话框，如下图所示。 

 

 

ZEMAX 默认的视场角是即为近轴视场角，其中「Weight」这个选项可以用来设罝各视场

角之权值，并可运用于优化。 

 



 

 

 

 

1-4 设罝波长 

可点击按钮列中的「Wav」来设罝波长，如下图所示： 

 

 

在波长编辑视窗里我们可以设罝不同的波长与其 Weight，ZEMAX 也有内建一些常使用波

长，可透过「Select->」这个选项来选择。在此例子可以透过挑选「F, d, C (Visible)」 这个选项

来设罝波长 0.486、0.587、0.656 (Microns)，单击「OK」即可 。 

 



 

 

 

 

1-5 键入透镜资料 

现在我们要键入 Lens 的参数。在 ZEMAX 是透过设罝依序排列的表面来建立出光学系统。

在此建立单透镜这个例子需要建立 4 个表面。 

 The object surface（OBJ）：设罝光线的起始点 

 The front surface of the lens(STO)：光线进入 Lens 的位置。在这例子里，这表面的位置也决

定了光阑(Stop)的位置 

 The back surface of the lens(2)：光线从 Lens 出来并进入空气中的位置。 

 The image surface(IMA)：光线追迹最后停止的位置，不可以在 IMA 这个之后设罝任何的

表面。这个位置上并非存真实的表面，而是一个哑的表面。 

 



 

默认的 LDE 视窗中只有 3 表面（3 列），为了符合此例子需要增加一个表面。将游标移到「IMA」

并按下按键盘上的 Insert 键，即可产生「2」这个面。 

「OBJ」是第 0

面，「STO」是第 1 面，「2」是第 2 面、「IMA」是第 3 面。 

 

 

1-6 设罝透镜参数 

首先设罝 Lens 的材料为「BK7」，将游标移到第 1 面的 Glass 栏，键入 BK7 并按 Enter。

而此时 ZEMAX 便会去查寻数据库里 BK7 的光学属性，来决定其各个波长下之折射率。 

 

Lens 的厚度由第 1 面的 Thickness 栏来设罝，这个栏是指表面的中心点沿着光轴到下一个

表面的距离。孔径 25mm 厚度 4mm 的 Lens 是合理的，直接在「Thickness」栏内键入数值即可。 

 

接下来键入 Lens 的曲率半径，本例子使用一个左右曲率对称的 Lens，先将第 1 面的曲率

半径设罝为 100 mm，第 2 面的曲率半径设罝为-100 mm。在第 1 面及第 2 面的「Radius」栏键

入数据，正值表示曲率中心点在表面的右边，负值表示曲率中心点在表面的左边。 

 

「IMA」的位置就是设在 Lens 的焦距上，所以距离 Lens 大约 100 mm 左右，直接在第 2

面「2」的「Thickness」栏键入 100，即表示在 Lens 后面 100 mm 的位置就是下一表面的位置，

也就是「IMA」面的位置。 

 

LDE 的设罝如下所示： 

 



 

 

 

 

1-7 评估系统性能 

在 ZEMAX 中有很多分析功能可评估系统的质量好坏，其中一个最常用的分析工具是光线

扇形图(Ray fan plot)。可以点击「Ray」这个按钮或透过菜单 Analysis->Fans->Ray Aberration 来

开启这个功能。 

 

 

在点击之后会出现一个视窗，显示各光线与主光线 (Chief Ray)的光线象差 (Ray 

aberrations)，左边的图是显示 Y 或正切方向的光线象差，右边的图是显示 X 或弧矢方向的光线

象差。 

 

这个分析图表是以 0.588 microns 为主波长，其线型在原点附近斜率不为零，表示产生离

焦现象(Defocus)。 

 



 

 

 

 

1-8 使用解 

为了定标离焦(Defocus)，透过调整第 2 面「2」到 IMA 面的距离（焦距＝100mm）来解决

这个问题。Solves 是一个特别的功能，主要是针对特定 ZEMAX 的参数进行动态调整，以符合

某些特别的情况 

 

先要点击第 2 面的 Thickness 后，单击鼠标右键，将会出 Solve 的设罝视窗。 

 

 

在「Solve Type」里选择 Marginal Ray Height，然后敲点「OK」即可发现 LDE 视窗第 2

面的「Thickness」由 100 改变为 96，并且会出现「M」的记号。在次点击「Ray」这个选钮显

示光线扇形图(Ray fans plot)，可发现像差线条已由原本的斜线变为 S 的形状，而这表示此 Lens

 



 

有球差(Spherical aberration)。 

 

在 ZEMAX 的 Online Help 中有一个章有列出有关 Solve 的解释及讨论。 

 

1-9 设罝优化 

我们希望使用优化来修正这个例子的质量。除基本设计的形式之外，优化需要两个附加项： 

 设罝允许变动的参数，让ZEMAX可自由地在允许的范围内调整这个参数，以设计出更好

系统。 

 在数学上的观点上，需要设罝优化函数(Merit function)的描述，意即评估系统优劣的指标。 

 

这个例子内有 3 个参数适合被改变而来进行优化，包括两个表面的曲率半径以及透镜到

「IMA」面的距离。只要将游标移至第 1 面「STO」及第 2 面「２」的「Radius」栏及第 2 面

 



 

的「Thickness」栏点击并按 Ctrl+Z 或按鼠标右键选，在「Solve Type」选 Variable 这个选项。

如此各个选项之后将出现「V」的字样。 

 

 

 

1-10 建立绩效函数 

优化函数(Merit function)被定义于优化函数编辑器(Merit function Editor, MFE)。单击键盘

的 F6 或点击菜单的 Editors->Merit Function 即可开启编辑视窗(MFE)。 

 

 

从 MFE 点击 Tools->Default Merit Function 会出现一个 Default Merit Function 的视窗，点

击「Reset」后再点击「OK」。后面我们还会说明这个视窗的相关设罝，现在先以默认条件进行

优化。 

 



 

 

 

 

1-11 增加限制条件 

接着修正绩效函数(Merit function)，包括系统焦距的需求。将游标移在 MFE 的第一列并单

击按键盘的 Insert 来产生新的一列，在此列的 Type 栏上键入 EFFL 后按 Enter。这个操作数的

功能是在运算出系统有效焦距，在计算有效焦距时必须设罝参考的主波长(Primary Wavelength)，

在此例子里使用第二波长为参考波长，所以在第一列的「Wav#」栏中键入为 2。接着在「Target」

栏里键入 100 并按 Enter，「Weight」设为 1 再按 Enter，最后将此视窗关闭，虽然关闭编辑视窗

但设罝已储存，并不会遗失。 

 



 

 

 

 

1-12 运行优化 

点击「Opt」或 Tools->Optimization，便会出现 Optimization 的视窗。 

 

 

在优化的对话视窗里，如果「Auto Update」选项被勾选，则当在运行优化时，所有开启

的分析视窗如 Ray fans plot 以及 LDE 的数据将及时变动。在此请点击「Automatic」这个按钮

来进行优化。 

 

 

 

1-13 光线扇形图 

 



 

这个优化的动作是调整 Lens 的曲率半径使透镜焦距接近 100 mm，并调整透镜与成像面的

距离，以消除离焦(Defocus)。其是利用最小波前误差之均方根值为依据进行优化，而此次的优

化的并没有使焦距完完全全等于 100 mm，这是因为我们所设罝的有效焦距操作数(EFFL)只是

绩效函数(Merit function)中众多操作数的一项而已，所以在运行优化时也需要符合其它优化条

件。其实在许多的设计之中，可以透过 LDE 里 Solve 功能来使调整焦距以符合设计需求，而不

需使用 MFE 的操作数。 

 

下图所示是经过优化后的光线扇形图(Ray fans plot)，其最大像差(Maximum Aberration)约

为 300 microns。 

 

 

 

1-14 二维设计图 

点击 Analysis->Layout 或点「Lay」这个选项便可以显示 2D 设计图(Layout)。此 2D 设计

 



 

图的视窗上点击 Settings->Number of Rays->7->OK 即可显示出如下之图。 

 

 

 

 

 



 

 

1-15 弥散斑 

在 ZEMAX 众多的分析工具里，除了常使用光线扇形图来分析设计系统的光学性能之外，

另外也有一个分析功能－弥散斑(Spot Diagrams)也是一个相当常用的分析图表。弥散斑(Spot 

Diagrams)可以显示出平行光束通过光学系统后聚焦于成像面上的斑点。可点击 Analysis->Spot 

Diagram->Standard 或点击「Spt」即可显示出光斑(Spot Diagrams)的分析图。 

 

 

如下图所示，可由图表判断其 Stop 的图表大约有 400 microns 的半径大小，而 Airy Disk

有 5.7 mircons。也可以由此图看出整个系统的像差，由于不同的波长其之焦距点也不一样，所

以其成像会产生模糊现象。 

 

1-16 光程差扇形图 

另一个常用的分析工具是 OPD Fans，这个图是显示光程差(Optical Path Difference)，此图

 



 

与光线扇形图一样采用主光线(Chief ray)为参考光，显示光离开光瞳(Exit Pupil)后的光程差，而

光线扇形图(Ray Fans Plot)一样也是显示光程差但其是显示光在 IMA 面上的光程差。可点击

Analysis->Fans->Optical Path 或点「Opd」即可显示光程差扇形图(OPD Fans Plot)。 

 

 

 

 

1-17 进一步分析 

这个设计够好了吗?当波前像差(Wavefront Aberration)小于 1/4 的波长时，则需考虑到透镜

的衍射极限(Diffraction Limited)（有关这类的讨论可在使用手册(User's Guide)里找到详细的说

明）。在此例子还不需要考虑到衍射极限。为了改善系统的光学性能，设计者都必须了解光学

系统中那一些像差限制了系统的光学性能，以及要进行什么修正才可以有效的处理像差问题。 

 



 

 

在这一次的设计中，优化后仍然有轴向色差(Axial Color Aberration)及球差(Spherical 

Aberration)。如果在光线扇型图(Ray Fan Plot)中发现原点部分的曲线斜率不为零（即系统含有

离焦），这是因为优化的过程 ZEMAX 透过近轴焦点(Paraxial Focus)的移动来补偿球差，以达到

最小的球差(Spherical Aberration)。 

 

就色差(Chromatic Aberration)而言，焦距的变动是随波长而异，可以在 Chromatic Focal Shift 

Plot 看出来。点击 Analysis->Miscellaneous->Chromatic Focal Shift，而分析图是显示出波长与焦

距位移的关系图。如下图所示 

 

 

所以虽然此例子已作了最佳化，但仍然有像差存在，仍有设计及进步的空间。 

 



 

 

 



 

 

例子2 座标变换 (Coordinate Breaks) 

 

2-1 座标变换 

在 ZEMAX 里，表面的定义是架构在局部座标系统内。 

 在 ZEMAX 每个表面皆有其局部座标系统 

 每个表面皆可为下一个表面定义新的座标系统 

例如：当表面厚度为 50 mm，意即下一个表面定位在距离这个表面 50 mm 的位置。 

 

表面座标变换是用于当系统在 X 或 Y 轴有位移时定义新的座标系统，同样的也可对 X,Y

或 Z 轴进行旋转。进行座标变换的表面并无光学属性，事实上它只是定义新的座标系统。 

 

2-2 顺序旗标 

在转换座标系统时，需要标记转换的顺序。这是因为在座标转换时，先倾斜再旋转与先旋

转再倾斜其结果是不同的。同样地，座标轴旋转的顺序也会对座标旋转的最后结果有影响。 

 

顺序标记的参数是用在定义座标变换时转换和旋转的顺序。假使顺序标记为 Decenter then 

Tilt，则转换的顺序为：先做 X 轴离轴再做 Y 轴离轴（这是正交系统，所以离轴的顺序并不影

响结果），接着倾斜的顺序依序是 Z 轴然后是 Y 轴最后是 X 轴，而全局倾斜的顺序一样是 Z 轴、

Y 轴、X 轴。 

 

如果顺序标记为 Tilt then Decenter，转换的顺序将变成：先倾斜局部 X 轴然后是 Y 轴最后

是 Z 轴，（全局的顺序则为 Z 轴、Y 轴、X 轴），再来才是离轴（同样地，X 轴离轴与 Y 轴离

轴的顺序并不影响结果）。至于 Z 轴的离轴都是在所有座标转换完成后运行。 

 



 

 

总结，若顺序标记为 Decenter then Tilt，则座标变换的顺序为 X 离轴、Y 离轴、Z 倾斜、Y

倾斜、X 倾斜、Z 离轴（全局与局部相同）。若顺序标记为 Tilt then Decenter，则座标变换的顺

序为 X 倾斜、Y 倾斜、Z 倾斜、X 离轴、Y 离轴、Z 离轴（全局的倾斜顺序为 Z 轴、Y 轴、X

轴）。顺序标记将混合倾斜与离轴，达到最少的表面数的设计。 

 

 

2-3 座标变换的应用 

使用座标变换的应用有： 

 旋转面镜 

 锥形组件的离轴设罝 

 公差分析 

 孔径离轴系统 

所有的应用都有最少一个(通常是两个)的座标变换表面。 

 

 

2-4 工具－转折面镜 

新增旋转面镜的工具可以使用在改变局部座标系统以及应用在需倾斜面镜的系统。这个工

具将会在指定表面的前后新增两个座标变换的哑表面。 

 第一个座标变换的哑表面，将会旋转并倾斜面镜的座标系统。 

 如此新的表面将会垂直新座标系统的光轴（即为 Z 轴），且其表面材料为 MIRROR。 

 第二个座标变换的哑表面，将在次变换座标系统（入射角=反射角）。 

 

所有使用此工具的系统将会修正并新增镜面。 

 转换将会改变系统部分参数的正负号 



 

 任何需要的参数（例如光栅阶数）将会被修改 

此外，使用新增旋转面镜这个工具时，必须使用在空气中的哑表面（直接新增一个表面即可）。 

 

消除旋转面镜的工具会消除旋转面镜并回复被座标变换的面。假使面镜距下一个面的距离

为 0 又使用座标变换，则镜面及座标变换将会被消除。若面镜使用座标转换而其厚度为 0，则

该表面将会被消除。且任何消除的厚度值将会立即加入至前一个面厚度。所有跟随的表面参数

将会修正以维持合适的符号。 

 

 

2-5 例子－转折面镜 

从 ZEMAX\Samples\Tutorial folder 载入「Fold mirror.zmx」。我们将会在近轴透镜和成像面

间置入旋转面镜。注意在哑面上所需键入的参数只有 Z 轴上的距离。 

 

 

 

2-6 新增转折面镜 

在主选单上的 Tools 选取「Add Fold Mirror」。在应用的参数上选取依 X 轴转 90 度。点击 OK。

然后观看 3D Layout 

 

 



 

 

2-7 修正透镜资料编辑器 

注意 LDE 的改变： 

 会新增两个座标变换的表面。 

 被旋转表面的玻璃材料为「Mirror」。 

 面镜与下个表面之间的距离，将设罝在第二个座标变换的表面上。 

 在反射后系统参数的符号需要改成负号。 

 注意在第二个座标变换的表面使用「Pick-up」的解。 

须确保每个改变都有运行。 

 

 

 

 



 

 

 

 

2-8 删除转折面镜 

要消除旋转面镜，仅需从主选单的 Tools 点击「Delete Fold Mirror」，然后键入旋转面镜的

号码。 

 

 

旋转面镜和座标变换的面会被移除。前一个面的厚度将会被修正为包含原始厚度的哑面。 

 

 

 



 

 

2-9 倾斜与离轴 

一个或多个组件的倾斜与离轴是十分有用的。在公差分析中，常见的例子是比较原始座标

与变化后座标的关系。离轴可在第二个座标变换的面利用负值的 Pick-Up 解。然后非正交的系

统转换(倾斜和离轴，多轴倾斜)都与顺序有关。解开倾斜与离轴的混合转换的顺序必需颠倒以

还原原始座标系统。此外，两个座标转换必需在同一光学系统内同样的位置。 

 

 

2-10 工具－倾斜与离轴 

倾斜/离轴组件工具是用来运行倾斜/离轴混合功能。此工具在插入座标变换和哑面的倾斜/

离轴时是必需的。在 Tutorial 资料夹载入 Petzval.zmx 这个文件。我们将把第二群（意即表面 4

到表面 6）作离轴然后再做倾斜。 

 



 

 

 

 

 

 

2-11 例子－倾斜与离轴 

在主选单 Tools->Miscellaneous 中选取「Tilt/Decenter Elements」。在 Y Decenter 键入 5mm，

然后在 Tilt X 键入 10。在 Order 的选项选 Decenter then Tilt。 

 



 

 

 

注意最后一个镜片是准直于光轴 

 

 

 

 

2-12 处理倾斜与离轴 

观看透镜资料编辑器。 

 



 

 座标变换的面插入在镜片群的前后 

 第一个座标变换的哑表面，先进行离轴然后倾斜透镜的座标系统。 

 第二个座标变换的哑表面，先回复倾斜再回复离轴座标系统。 

在第一个座标变换的座标轴上利用第七个面上厚度解的选项决定第二个座标变换的位置。第八

个面上的厚度解将会回复第七个面的位置。 

 

 

 

 

 

2-13 设罝倾斜与离轴 

表面的倾斜和离轴允许改变座标系统中表面前后的光路径。表面的倾斜/离轴可以想成是座

标变换根据表面或根据其它座标变换。在透镜资料编辑器使用表面倾斜和离轴估计哑的座标变

换，允许些许杂乱的显示画面。现在使用表面倾斜和离轴并不支持表面倾斜和离轴的优化。 

 



 

 

 

 



 

 

例子3 牛顿式望远镜 (Newtonian Telescope) 

 

3-1 牛顿式望远镜 

牛顿式望远镜是 Stigmatic 光学系统的例子。牛顿式望远镜即是一个简易的抛物线型反射

镜。光线是由无限远处的物点所发出，并在焦点处形成完美(几何)像点。抛物面可提供无球差，

只有轴上的高阶像差的质量。 

 

我们将设计焦距 1000 mm，F/5 的望远镜。根据表面焦度(Power)的定义，可知曲率半径为

2000 mm，而孔径直径为 200 mm。我们将使用轴上(On-Axis)视场角及默认的波长 0.55 μm。镜

面并不会产生色差，所以它并不需设罝多波长。开启全新的透镜资料编辑器(LDE)，只需点击

File->New。 

 

 

3-2 孔径、单位、视场角及波长 

孔径和透镜的单位可经由 System->General 所弹出的对话视窗进行设罝。就孔径来说，在

Aperture Type 选取「Entrance Pupil Diameter」，然后在 Aperture Value 键入「200」，此时透镜的

默认单位为 mm。我们也将使用默认的视场角和波长。 



 

 

 

 

3-3 键入透镜资料 

望远镜需要建构三个序列性描光的面： 

 对象，定位在无限远的距离 

 镜面表面，定位在 Stop 的位置 

 成像面，定位在镜面的近轴焦点上 

 

镜面表面需在 Glass 这个栏键入「Mirror」。在镜面表面反射后，需改变曲率半径的符号。

在 Stop 表面的曲率半径栏内键入-2000 mm，而厚度键入-1000 mm。 

 



 

 

 

 

3-4 评估系统性能 

开启弥散斑(Spot Diagram)，我们可将光斑尺寸与埃里斑(Airy Disk)在弥散斑上作比较。点

击弥散斑中主选单上的 Setting 选项。在「Show Scale」的下拉式选单中选取 Airy Disk，然后点

击 OK。 

 

 

RMS 光斑尺寸为 77.6μm。埃里斑(Airy Disk)的直径文本输出部分的光斑尺寸下方，其值为 6.7

μm 。 

 

 

 



 

 

 

3-5 定义抛物面 

我们没有满足衍射极限的原因是我们使用的是球面镜面。若要改变镜面的外型为抛物面，

我们需要在 LDE 中表面 1 的 Conic 这一栏内键入「-1」。 

 

 

 

3-6 抛物型反射罩 

 



 

在改变 Conic 值后，点击弥散斑(Spot Diagram)中主选单上的「Update」进行刷新。注意此

时 RMS 光斑尺寸为 0.000。如此即定义出完美的几何成像点。一个衍射极限的系统，系指其

整体系统性能趋近于边缘衍射效应，亦即系统的几何像差趋近于零。这样的系统应该使用衍射

分析工具。 

 

 

 

3-7 点扩散函数 

点扩散函数（PSF）是一个可用在分析衍射极限系统上，针对成像面能量扩散的分析工具。

观看 PSF 图，点击 Analysis->PSF->FFT PSF Cross Section 即可。我们看到，由衍射效应所产生

的影像并非是一个完美的像点，还是有能量的模糊。 

 



 

 

 

 

3-8 挡板 

观看设计的 Layout 图表（在按钮列上「Lay」的按钮）。成像面是定位在入射光束的光路

上，这个位置上的影像并不容易取得。任何企图在成像面捕捉影像的动作都将会阻挡许多入射

的能量。一般常见的解决方法为放置一旋转面镜(Fold mirror)，且与光轴夹 45 度的将成像光线

导离光轴。不过旋转面将依旧会遮蔽部分能量。 

 

假使您想看到入射光，可以新增一个表面在 Stop 之前，且距离 1000 mm。在「Lay」设罝

的对话框（点击右键即会跳出此对话视窗），改变显示的第一面为 1 并增加较多的光线然后观

看 Layout 图。 

 



 

 

 

 

 

 

3-9 增加转折面镜 

欲新增转折面镜，首先我们必需定义面镜的置放位置。面镜的尺寸应该尽可能地小型化而

且将影像完全导离光轴。当入射光束的直径为 200 mm 时，成像面最少必需在光轴上方 100 mm，

所以现在设罝旋转后的影像在光轴上方 150 mm，因此旋转面镜必须距面镜 850 mm（= 1000 mm 

– 150 mm）。首先改变面镜的厚度为-850 mm。在面镜与成像面之间插入一个新的表面，键入该

表面厚度为-150 mm。这个新增的哑面将会被指定为使用「Add Fold Mirror」工具的旋转面镜。

 



 

如此从面镜到成像面的总厚度依旧是 1000 mm。 

 

 

 

现在点击 Tools->Add Fold Mirror。设罝「旋转的面」为 3 然后点击 OK。如此即可新增旋

转面镜并将成像光束转向。您将会需要使用 3D 出图(Layout)观看设计图(按钮列上的「L3d」

按钮)。 

 

 

 



 

 

 

 

 

3-10 座标变换 

请看 LDE 变化。注意新增的面包围了第二个「面镜」。 

 

 

在透镜资料编辑器，可定义所有序列性表面的资料： 

 ZEMAX 只使用局部座标轴 

 



 

 

 每一个面的座标是藉由 Z 轴上每一个面的距离定义(亦即「厚度」这个栏)。 

 

所有的面是使用局部座标来定义。ZEMAX 可以评估任意面的全局座标以及与其它面的关

系。ZEMAX 每一个面都有其自有的局部座标系统。每个面可由下面的例子定义新的座标系统。

例如：当指定一个表面的厚度(Thickness)为 50 mm，则接下来的表面就会根据此表面的设罝在

空间中进行定位。 

 

座标变换是一个特殊的哑表面，用来定义相对于现在的座标系统而言的新座标系统。座标

变换定义的新座标系统不仅仅只有 Z 轴上的移动还有 X 或 Y 轴的移动，同时也包括 X，Y 和 Z

轴的旋转。 

 

运行旋转面镜 45 度，我们需要两个座标变换，而且通常是成对出现的。第一个哑表面定

义座标轴旋转 45 度，面镜就根据此座标系统，跟新座标系统的光轴（Z 轴）垂直。第二个哑

表面将座标轴再旋转 45 度，让旋转面镜所反射的光束符合入射角等于反射角。 

 

 

3-11 设罝挡板 

旋转面镜对望远镜系统的性能并无影响。弥散斑(Spot Diagram)和 PSF 图并无改变，还有

许多的方法可改善性能。注意光线从对象发出经过旋转面镜到达第一面镜，然后反射回到成像

面。在真实系统中，负责引导成像离开光轴的旋转面镜将会遮蔽部分的入射光束，因为采用

ZEMAX 的序列性描光，因此后面的表面并不会影响前面光线追迹。为了定义这遮蔽效应以接

近真实状况，我们必须置入一遮蔽平面至系统中。 

 

我们将使用一哑的表面来做遮蔽用。请在表面 1 的「Surf:Type」栏上点击鼠标左键两下，



 

开启表面 1 的属性对话框。选取 Aperture 标签，挑选孔径型态(Aperture Type)为「Circular 

Obscuration」并将其最大半径设为 16.7。 

 

 

 

 



 

3-12 挡板效果 

现在的 3D 出图(Layout)图表将会显示光线打到旋转面镜所产生的渐晕。这遮蔽效应是由扣

除光线所产生，可以基于计算看出任何方向的衍射。您可使用键盘的按键如 Page Up 或 Page 

Down 旋转您的出图，来观察不同的角度系统。注意 MTF 些微的扭曲，亦即 PSF 图表里的小

波瓣所代表的能量扩散。这是遮蔽所导致的对比度降低。 

 

 

 



 

 

 

 

 

 

 



 

 

 

 

 



 

例子4 消色差单透镜 (Achromatic Singlet) 

 

4-1 消色差单透镜 

这个例子需要 ZEMAX-XE 或 ZEMAX-EE 的版本。在这个例子中，将使用衍射表面－「二

元表面 2(Binary 2)」来设计消色差(Achromatic)之单透镜。透镜参数如下 

 系统孔径： 20 mm 

 视场角：近轴(on-axis) 

 波长：选择「F、d、C」 

 新增一个表面于 LDE（默认只有三个表面） 

 表面一 

曲率半径：变数 

厚度：10 mm 

玻璃：BK7 

 表面二 

曲率半径：使用解(Solve)「F/2」。将鼠标移至表面「2」之曲率半径的栏上，点击鼠标右键

并选择 F Number 的解类型，键入 F/#为 2。 

厚度：变数（点击此栏，单击键盘上的 Ctrl + Z）。 

 

接着建立绩效函数(merit function)，其条件为均方根(RMS) – 斑点半径(Spot radius) – 质量

中心(Centroid)。 

 



 

 

 

 

4-2 标准单透镜 

 进行优化。如下列分析图所示，系统的性能被球差(spherical aberration)所限制。 

 

 

 



 

 

 

 

 

4-3 新增衍射表面 

 为降低系统目前的球差与色差，将表面 1 的表面类型改变为「Binary 2」 

 



 

 将鼠标移至表面 1 之「表面类型」的栏 

 按下键盘的「Enter」 

 在表面 1 的属性对话框中选择「类型」的标签 

 单击四次「B」键 

这个表面类型将是「Binary 2」 

 

 

 

 

 

4-4 设罝衍射参数 

 接着从主选单的编辑器(Editors)中，选择额外资料编辑器(Extra Data Editor)。在表面 1，二

元表面上设罝： 

 



 

 设罝最大数目为 2 

 正规化曲率半径为 2 

 设罝「coeff on p^2」与「coeff on p^4」为变数 

 

再优化一次 

 

 

 

 

 

 

 

 

 



 

4-5 评估系统性能 

 再次观察优化后的系统性能，球差有明显下降，色差将被良好的平衡。 

 

 

4-6 相位属性分析 

 现在来判断此设计制造的可行性。可达到相位变化 2π的最小局部之放射半径为何?在扩展

(Extensions)主选单下，选择「Phaseplot」。从约 127 个周期横越表面。最小局部约为 0.055 mm，

放射距离约为 7.5 mm。 

针对四阶的二元表面，最小阶为 13.75μm。较高性能的八阶二元表面需要小于 7μm。 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 



 

 

例子5 变焦透镜 (Zoom Lens) 

 

5-1 变焦透镜 

ZEMAX 中 MC(Multi-Configuration，F7)功能的一个常见应用为变焦透镜设计。这个例子

将涵盖变焦透镜的基本设罝与优化。这里有个变焦透镜系统的简易规格： 

 有效焦距：75、100、125 mm； 

 入瞳直径：25 mm（F/3、F/4、F/5）； 

 三群镜组：皆为 BK7 与 F2 的胶合透镜； 

 透镜厚度：中心与边缘厚度须大于 2 mm，中心厚度须小于 10 mm； 

 透镜间距：中心与边缘距离必须大于 1 mm； 

 视场角度：近轴像高为 0、15.1、21.6 mm（针对 35 mm 的胶片）； 

 波长范围：F、d、C（可见光波段）。 

 

 

5-2 设罝系统参数 

开启系统(System)，一般(General)对话框。 

 在孔径标签(Aperture Tab)： 

 孔径类型：入瞳直径 

 孔径值：25 mm 

 按下「确认」。 

 在单位标签(Units Tab)： 

 确认透镜单位为毫米(Millimeters)。 



 

 

 

 

在这个设计中，我们将在设罝基本系统参数后键入场资料。 

 

5-3 初始透镜参数 

 我们开始最基本的设计形式。开始时使用三群透镜组件，每一群都使用 BK7 与 F2 组成之

 



 

胶合透镜。透过冕牌与火石材料的结合可以有效地降低色差。这个基本的对称型式则可以有助

于平衡像差。请依照下图所示之参数键入基本设计于 LED（请忽略半高(Semi-Diameter)栏）。（或

者是，您可以从\Samples\Tutorial\Tutorial zoom.zmx 载入文件） 

 

 

 

 

5-4 设罝视场角 

 开启场(Field Data)资料对话框。 

 选择「近轴像高(Paraxial Image Height)」单选按钮 

 使用三个场位置 

 Y 场为 0.0、15.1 以及 21.6 mm 

 



 

 按下「OK」 

 

 

 

5-5 设罝波长 

 开启波长(Wavelength)资料对话框 

 从下拉式选单中挑选「F、d、C(visible)」 

 按下「Select」 

 按下「Ok」 

 



 

 

 

 

 

5-6 定义多组态透镜 

 



 

 MC 的参数将设罝于多组态编辑器(Multi-Configuration Editor(MCE))。选择编辑器(Editor)，

然后从主选单列中挑选多组态(Multi-Configuration)，开启 MCE（或使用功能键 F7）。从 MCE

主选单列中挑选 Edit，然后插入组态(Insert Config)两次。现在 MCE 将有三行组态。只有被键

入进 MCE 的参数才会在组态间有所差异。没有被键入进 MCE 的参数将保持为定值。 

 

 我们将允许所有透镜个别设罝 MC 参数为 MC 变数。将游标移至 MCE，按下「Insert」键

三次。现在 MCE 有四个列。这些将被设罝为表面 3、4、7 以及 10 的厚度。 

 

 

 

5-7 键入多组态参数 

 键入参数。将游标置于 MCE 的最左行的第一列并且按下左键。这将开启多组态操作数

1(Multi-Config Operand 1)的对话框。用来设罝表面三的厚度。以下是键入资料的快速方式。 

 按下「T」键三次。在「操作数类型(Operand Type)」下拉式选单内将选择「THIC」。 

 按下 Tab。游标将被移置「表面(Surface)」栏。 

 按下 3 以选择表面三。 

 按下「OK」。 

 

 针对其它三个表面再设罝三次： 

 右键、「T」、「T」、「T」、Tab、4、Enter 

 



 

 右键、「T」、「T」、「T」、Tab、7、Enter 

 右键、「T」、「T」、「T」、Tab、1、1、Enter 

 在下拉式选单里搜寻第一个字符。「10」是第二个被选择的。 

 

 

 

5-8 设罝多组态变数 

 设罝编辑器内所有项目为 MCE 变数。(Ctrl+Z) 

 

 在 LDE，也设罝所有透镜的曲率与厚度为变数。 

 

 

5-9 建立多组态绩效函数 

 



 

 开始建立默认的绩效函数(Default merit Function)。开启 MFE(功能键 F6)，在 MFE 主选单

挑选 Tools\Default Merit Function 

 选择：RMS – Spot Radius – Centroid 

 出瞳积分方法(Pupil Integration Method)选择 Gaussian Quadrature 

 厚度边界条件 

 玻璃：2、10、2 

 空气：1、200、1 

 

 

 

5-10 增加限制条件 

 注意在 MFE 的第一个操作数为「CONF」。所有 MC 的绩效函数将以此操作数开头，「CONF」

 



 

操作数指示的操作数参照哪个组态。第一个键入被参照的为组态一，可透过「Cfg#」这个栏可

以得知。接着是操作数「CONF 2」以及应用于组态二的操作数，然后是组态三。 

 

 我们还需要增加新的操作数来限制每个系统的聚焦长度，我们将放置操作数于绩效函数的

上面。而每个「EFFL」必须伴随一个「CONF」操作数。组态一所限制的聚焦长度为 75 mm、

组态二为 100 mm、组态三为 125 mm。每个 EFFL 操作数使用权值「1」。 

 

 

5-11 设罝透镜尺寸 

 所有组态的镜组必须有同样的尺寸(半高(Semi-Diameter))。这里可以透过解(Solve)来进行

限制。「最大(Maximum)」半高的解将被设罝每个组态中，每个表面半高的最大要求，这将确保

边缘厚度的边界条件不被违反，不会产生异常的透镜。 

 

 解设罝： 

 将游标置于表面一的半高栏上，并且按下 Enter。 

 按下「M」以选择「Maximum」的解型态。 

 按下 Enter 接受设罝。 

 按下向下键(Down Arrow)到表面二。 

重复其余的面，除了孔径以及成像面。快速设罝如下所示： 

 Enter - 「M」- Enter – 向下键(Down Arrow) 

 Enter - 「M」- Enter – 向下键(Down Arrow) 

 



 

 等等... 

（Samples\Tutorial\Tutorial zoom 2.zmx 的透镜文件显示到这里的所有内容） 

 

 

5-12 运行优化 

 这个透镜已经准备好进行优化。我们希望看到优化过程中所有组态的相对外型。我们将使

用 3D 出图(Layout)(按钮列上 L3d 按钮)。接着开启 3D 出图的设罝对话框(Settings Dialog Box)。

改变设罝 

 光线数：5 

 组态：所有 

 点击「Hide Lens Edges」 

 点击「Suppress Frame」 

 Y 位移：75 

然后按下「OK」。 

 



 

 

 

 

 

 



 

5-13 评估系统性能 

 开启优化工具对话框(Optimization Tool Dialog Box)(Opt 按钮)，点击「Auto Update」并且

单击「Automatic」。完成优化后，观察出图以及一些分析图表。 

 

 

 

 



 

 

 



 

 

 



 

例子6 公差 (Tolerancing) 

 

6-1 概论 

 公差分析将有系统地分析些微扰动或色差对光学设计性能的影响。公差分析的目的在于定

义误差的类型及大小，并将之引入光学系统中，分析系统性能是否符合需求。Zemax 内建功能

强大的公差分析工具，可帮助在光学设计中建立公差值。公差分析可透过简易的设罝分析公差

范围内，参数影响系统性能的严重性。进而在合理的费用下进行最容易的组装，并获得最佳的

性能。 

 

6-2 公差 

 公差值是一个将系统性能量化的估算。公差分析可让使用者预测其设计在组装后的性能极

限。设罝公差分析的设罝值时，设计者必须熟悉下述要点： 

 选取合适的性能规格 

 定义最低 的性能容忍极限 

 计算所有可能的误差来源(如：单独的组件、组件群、机械组装等等…) 

 指定每一个制造和组装可允许的公差极限 

 

 

6-3 误差来源 

 误差有好几个类型须要被估算 

 



 

 

制造公差 

 不正确的曲率半径 

 组件过厚或过薄 

 镜片外型不正确 

 曲率中心偏离机构中心 

 不正确的 Conic 值或其它非球面参数 

材料误差 

 折射率准确性 

 折射率同质性 

 折射率分布 

 阿贝数(色散) 

组装公差 

 组件偏离机构中心(X,Y) 

 组件在 Z.轴上的位置错误 

 组件与光轴有倾斜 

 组件定位错误 

 上述系指整群的组件 

周围所引起的公差 

 材料的冷缩热胀(光学或机构) 

 温度对折射率的影响。压力和湿度同样也会影响。 

 系统遭冲击或振动锁引起的对位问题 

 机械应力 

剩下的设计误差 

 



 

 

6-4 设罝公差 

 公差分析有几个步骤须设罝： 

 定义使用在公差标准的」绩效函数」：如 RMS 光斑大小，RMS 波前误差，MTF 需求，使

用者自定的绩效函数，瞄准…等 

 定义允许的系统性能偏离值 

 规定公差起始值让制造可轻易达到要求。ZEMAX 默认的公差通常是不错的起始点。 

 补偿群常被使用在减低公差上。通常最少会有一组补偿群，而这一般都是在背焦。 

 公差设罝可用来预测性能的影响 

 公差分析有三种分析方法: 

 灵敏度法 

 反灵敏度法 

 蒙地卡罗法 

 公差分析需要对误差值的来源范围作设罝。 

 

 

6-5 公差操作数 

 公差分析会运用下面的操作数： 

 

 TRAD, TCUR, TFRN：所有描述表面焦度的误差 

 TTHI：描述组件或空间厚度的误差 

 TCON；描述 Conic 常数的误差 

 TSDX, TSDY：表面离轴的误差(镜片长度单位) 

 TSTX, TSTY：表面倾斜的误差(角度) 

 TIRX, TIRY：表面倾斜的误差(镜片长度单位) 



 

 TIRR：表面不平整度的误差(用球差和像散) 

 TEXI, TEZI：表面不平整度的误差(用 Zernike 条纹或标准多项式) 

 TIND, TABB：折射率,阿贝数的误差 

 TPAR, TEDV：参数或外加资料值的误差 

 TEDX, TEDY：组件的机构离轴 

 TETX, TETY, TETZ：组件的机构倾斜 

 TUDX, TUDY, TUTX, TUTY, TUTZ：组件的离轴或倾斜由使用者自订的座标定义 

增加可用于非序列性组件的新参数 

 

6-6 双透镜的公差分析 

 载入 Samples\Tutorial folder 中的「Tutorial tolerance.zmx」文件。这是一个近轴的双透镜设

计。我们将建立本系统的公差分析。 

 

 

 



 

 

 

6-7 制造与组装公差 

 在开始本设计的公差分析之前，我们需要定义所有可能的误差来源。首先从 ZEMAX 主选

单上点击 Editors->Tolerance Data，即可开启 Tolerance Data Editor(TDE)。然后在 TDE 视窗中的

主选单中，点击 Tools->Default Tolerance 开启 Default Tolerance 对话框。直接点击「OK」产

生默认的公差操作数。如此即是同意默认的公差容忍度。此外背焦的距离是默认的补偿部份。 

 



 

 

 

 

 

6-8 误差描述 

 



 

 Tolerance Data Editor 现在包括有 41 个项目。第一个操作数「COMP」定义表面 4 的厚度

做补偿部份。而「TWAV」这个操作数，系指针对任何条纹误差的测试波长。其它的操作数分

别用于定义下列误差： 

 四个面的曲率半径 

 四个面的面不平整度 

 两个组件和一个间隙的厚度误差 

 两个玻璃的折射率或阿贝数的误差 

 四个面皆有两个方向的离轴和倾斜。针对球面，公差分析仅有楔形或离轴 

 两个组件皆有两个方向的离轴和倾斜 

如此便包括所有设计上可能的制造和组装的公差 

 

 

 



 

 

 

 

6-9 灵敏度分析 

 灵敏度分析定义各个缺陷对系统性能的影响。这些影响经由统计上的总和以估算出系统性

能。藉由给定公差的范围，以了解那些会造成系统性能的改变? 

一系列独立的公差估计： 

 半径的改变 

 厚度的改变 

 倾斜或离轴的改变 

 

 每一个操作数，补偿部份会修正标准值至最小。我们皆认同所有的默认操作数除了一个参

数，两个组件间的距离。虽然设罝两者的间距为「0」，其是以顶点为量测的基准，公差的范围

最小为「0」最大为「0.2」。如此第二面将不会进入第一面。 

 

6-10 初步公差分析 

 在默认公差范围完成灵敏度分析后开始公差分析。在开启的文件中减低 RMS 光斑的大小

将会使缺陷突显。开始公差分析需点击主选单中的 Tools>>Tolerancing(或 Ctrl+T)，此举将会开

 



 

启公差分析的对话框。请务必确认「Comp：Paraxial Focus」已选取，此举利用近轴焦点的修

正来重新定义成像面的位置。 

  

 使用 RMS 光斑半径做为公差分析的标准。公差分析的方式选灵敏度法。 

如果有需要的话，请确认「 Show compensators」已勾选。将「Monte Carlo」的选项设为 0。如

此即可点击 OK。 

 

 

6-11 公差分析结果 

 运算完成后，「文本阅读器」将会列出公差分析的结果。第一部份描述所有的公差操作数。

接下来列出使用在分析的公差标准值。这是依据每个操作数独立公差分析的结果，包括参数的

改变量，标准值的结果，标准值改变量与微小值的关系，焦点补偿的改变量。 

 



 

 

 

 

6-12 统计分析 

 下列灵敏度分析是统计上的资讯： 

微小的 RMS 光斑半径： 

 基本的标准值 

估计改变量： 

 每个操作数的基准为 

 每个操作数利用平方或平均将最大和最小的误差值 

 取其均方根(应用在最严苛的条件)  

估算 RMS 光斑半径： 

 加总微小值和估算改变量(定义有效的范围在系统性能上) 

可见默认公差的范围太宽松 

 



 

 

 

 

6-13 反灵敏度分析 

 反灵敏度分析常用在限制公差参数的范围以控制系统性能最大的降幅。允许的误差皆由误

差来源分裂出来的。 

反灵敏度的方法： 

 反最大值的模式：旨在单独地修正参数的范围使得最后的标准值所对应的参数近乎极限。 

 反增加量的模式：旨在单独地修正参数的范围使得最后的标准值改变量符合参数的范围几

乎等于增加量。 

 

 在反最大值的模式，有提供使用者自定极限的方法。 

 极限定义了每个公差分析参数的最大标准值。 

 极限值必须较一般条件严苛。 

 



 

 

 

 分析性能可藉由最小参数值来定义。 

 比较绩效函数到极限 

 假使低于最大值，移动范围的极限内对组件不会有影响 

 假使超过最大标准，将会缩小公差范围直到符合极限值 

 运行某些在最大参数的数值 

 参数的范围一般不会是对称的 

 

 运行的过程将会不断的重复直到评价系统的绩效函数降至预期的程度。反增加量的模式也

是近似的，除了标准最大增加量是自订的而非求极限。 

 

 

6-14 个别分析视场角/组态 

 假使分离视场角/组态的功能未选取，反灵敏度分析将会平均所有的视场角及组态。 

 某些视场角或组态也许对某些扰动有明显的冲击 

 关于这些资讯在默认的灵敏度分析条件下可能会隐藏在平均值内 

 

 假使选取分离视场角/组态的功能，在每个视场角每个组态都是独立计算。每个视场角皆须

符合反最大值模式的极限值。 

 公差分析的参数范围皆须修正到每个视场角每个组态都在极限值内。 

 

 在反增加值模式，每个公差参数范围皆须修正至每个视场角每个组态的值降低至不超过增

加量。最差的视场角的位置即可定义参数的范围。 

 



 

6-15 限制公差范围 

 举个例子来说，假设其需求为 RMS 光斑大小不能较正常的差 150%。求得正常的绩效函

数值，请开启 Tolerance 对话框(Ctrl+T)并点击其中的"?"标签。而 mode 则选 Inverse 的类型。正

常的绩效函数值为 3.5microns(0.0035 mm)。这表示我们设罝的绩效函数必须小于 5.25microns。

我们需要展开这些误差在所有可能的因素。假使任何一个参数所造成的误差多于对系统的贡

献，则其整体效应就会是明显的不好。 

 

 

 

6-16 设罝限制条件 

 假设没有参数可以让标准值降低超过 0.5microns，或产生一绩效函数超过 4.0microns。 

响应范围：  

 假设所有的参数有相同的贡献且平均分配误差由全部的参数 

 假设某些统计相依且平均分配误差由均方根的参数，真实的结果在中间的部份 

 



 

 

在对话框中的」?」。在# Monte Carlo Runs 键入 20。这是产生 20 条由随机数打到镜片上。在

Save Monte Carlo Runs 键入 20 将会在计算后保存。点击 OK 开始运行反向公差分析 

 

6-17 修正公差范围 

 在反灵敏度里，参数的范围将会被修正，假如需要的话，所以就是最大标准值。检查统计

摘要。计算的标准值超过期望的最大值。整个焦点的位置需要 0.66mm。 

 

 

 

6-18 蒙地卡罗分析 

 统计分析提供有灵敏度或反灵敏度是假设每个参数对允许的最大值有干扰，而且误差皆是

独立的。在真实系统中，误差与公差范围有着统计分布的关系。蒙地卡罗是将随机数引入的方

法。 

 



 

 

每个参数所受的影响都是随机的： 

 事先定义参数的范围 

 合适的统计分布 

 Normal (Gaussian)  

 Uniform 

 Parabolic 

 User-defined 

 

优化对系统的干扰会整个加总 

 某些误差对其它误差有补偿的作用 

 例子：单透镜，R1 = 25 mm, R2 = -25 mm 

 干扰后透镜：R1 = 25.2 mm, R2 = -24.8 mm 

 所以整个误差的影响即被取消 

 

6-19 蒙地卡罗统计 

 默认的分布是正常的误差分布。 

 正常的统计(也被称为高斯统计)：意即「钟形曲线」。假设有一点在由小到大的 1/4 的分布

上 

 其宽度可由使用者修改 

 应用在多数的误差分布都十分良好，由其对大量的分析和许多的参数 

观看 Monte Carlo 20 次后的结果。这资料可以在公差分析后获得。这表示约有 50%的镜片超出

预期的范围。背焦会修正至 0.78mm 

  



 

 

 

 

6-20 进一步分析 

 进一步限制参数范围以达到较高比率的成功案例是必须的。这可藉由降低最大标准和重新

运行反灵敏度分析或选取降低某些参数的范围。此目的是要定义公差参数以提供合理的平衡在

性能和花费间。修正公差范围可在 TDE 或选取 Tools，然后公差摘要可由主选单选取。 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 



 

例子7 混合式非序列 (NSC with Ports) 

 

7-1 混合式非序列 

在 NSC with Port 的设计中，系统使用序列性模式中所定义的系统孔径(System Aperture)与

场(Field)。光线从每个被定义的场点(Field Point)射向系统孔径，并且穿越非序列性表面(NSC 

Surface)前的所有序列性表面。 

 

随后光线进入非序列性模式的入口端口(Entry Port)，并开始在非序列对象群(NSC Group)

中进行传播。当光线离开出口埠(Exit Port)将继续追迹剩余的序列性表面，直至成像面。 

 

非序列性对象群可透过多个非序列性表面进行定义。NSC with Ports 常常被用来仿真不易

建立于序列性模式的光学组件。在此我们将着重在多焦透镜(Multi-Focal Lens)上：曲率半径为

孔径位置的函数之光学组件。这个透镜将有四个不同的局部。 

 

7-2 例子－混合式非序列 

在功能列中单击「New」按钮来开启新的 LDE(Lens Data Editor)。 

 

 

 开启一般资料对话框(General Data Dialog，System->General)，在孔径页里设罝： 

 孔径型态：入瞳直径(Entrance Pupil Diameter)； 

 孔径尺寸：38 mm。 

 



 

 

 

在非序列性页里设罝： 

 最大崁入对象数(Maximum Nested/Touching Objects)（对象内崁入对象的层数）为 9； 

 点击「OK」来关闭对话框。 

 



 

 

 

使用默认场，轴上(On-Axis)。 

 

 

使用默认波长，0.55 μm。 

 



 

 

 

 在 LDE 中的光阑(Stop)之后新增一个表面，这个表面将定义非序列模式的出口端口(Exit 

Port)尺寸。 

 

 

改变表面 1 的表面型态为非序列性组件(Non-Sequential Component)： 

 在表面 1 的表面型态(Surf:Type)栏上点击鼠标右键； 

 单击键盘的「N」键来选择表面型态。 

 点击「OK」来关闭对话框。 

 



 

 

 

 

7-3 出口埠 

出口端口的位置将透过非序列性表面（在此为表面 1）的参数栏进行设罝，出口埠的尺寸

将透过非序列性表面后的表面半高(Semi-Diameter)设罝其半径。出口端口的位置： 

 出口端口位置(Exit Loc Z)：25 mm； 

 显示埠(Draw Ports?)：3（这将在设计图(Layout)中画出入口埠与出口埠，默认 0 将不画出

此两埠）。 

 

 

出口埠半径大小： 

 表面 2 之半高：25 mm； 

 表面 2 之厚度：80 mm。 

 



 

 

 

 

 

 

7-4 非序列组件 

可透过置入不同曲率半径与边缘直径的实体透镜对象来设罝多焦透镜。这对象将透过非序

列性组件编辑器(Non-Sequential Component Editor, NSCE)进行定义，在 NSCE 中设置对象有个

很重要的限制。 

 多重对象中，重迭体积的属性由 NSCE 中最后一个对象所定义，这意味我们需要从最外层

开始定义透镜对象至最内层； 

 每个对象型态为「标准透镜(Standard Lens)」。 

 

 开启 NSCE（Editors->Non-Sequential Components），使用 Insert 键或在 NSCE 的菜单栏中

 



 

使用 Edit->Insert Object 在 NSCE 中插入数列。 

 

 

 将游标置于 NSCE 的对象 1 上，并单击鼠标右键来开启对象属性对话框。设罝对象 1 的型

态为标准透镜(Standard Lens)，接着点击「OK」。 

 

 

7-5 对象属性 

设罝 NSCE 内的透镜参数： 

 Z Position：5 mm； 

 Material：BK7； 

 Radius 1：50 mm； 

 Clear 1/Edge 1：20 mm（忽略错误信息）； 

 



 

 Thickness：10 mm； 

 Clear 2/Edge 2：20 mm； 

 保留其它所有参数为默认值。 

 

 

 

 

7-6 非序列性透镜对象 

透镜对象外部的参数现在已被定义，下图为三维设计图（只显示表面 1、2，光线数目为 7）。 

 

 



 

 

7-7 复制对象 

系统中的其它对象与对象 1 相似的， 因此先将 NSCE 中对象 1 的整列突出显示（Shift + 键

盘方向键的右键），使用 Ctrl + C 复制所有资讯，使用 Ctrl + V 新增六个复制的透镜。 

 

 

 

7-8 定义多焦透镜 

其它透镜对象将被崁入对象 1，透镜对象的高度分别为半径 15 mm、10 mm 以及 5 mm。

针对对象 3、5 以及 7： 

 分别改变其 Clear 1/Edge 1 参数为 15 mm、10 mm 以及 5 mm。 

 分别改变其 Clear 2/Edge 2 参数为 15 mm、10 mm 以及 5 mm。 

 

 

 

7-9 表面折射 

如果透镜各有不同的曲率半径，光线何时会被透镜折射？在 ZEMAX 中透镜可以被崁入或

相互重迭，但是当各个透镜有不同曲率时，光线在到达内部实际组件前将被外部材料所影响并

 



 

被折射。因此物理上我们所想要的对象将无法被仿真。 

 

为了预防这个状况发生，我们需要内部部分局部为空气。对象 2、4 以及 6 将运行这份工

作。透镜内部没有设罝空气局部，光线将在到达内部透镜前在外面被折射（内部局部透镜半径

为 40 mm）。 

 

 

在透镜内部设罝空气局部，则光线在到达内部局部前不会被其它表面折射。 

 



 

 

7-10 空气透镜 

首先，移除对象 2、4 以及 6 的材料（将游标置于该保存格(Cell)并且单击键盘的「空白键

(Spacebar)」）。接着调整对象 2、4 以及 6 的 Clear 与 Edge 尺寸如下所示，分别为 15 mm、10 mm

以及 5 mm。 

 

 

 

7-11 调整焦距参数 

现在透过改变内部组件的半径来定义多焦透镜： 

 对象 3：Radius 1 = 45 mm； 

 对象 5：Radius 1 = 35 mm； 

 



 

 对象 7：Radius 1 = 25 mm。 

 

 

 

7-12 多焦透镜 

透镜的每个局部有不同的焦度(Power)、不同的聚焦位置。在三维设计图(Layout)设罝「光

线数目(Number of Rays)」为 55。 

 

 

 



 

 

 

 

7-13 运行优化 

许多混合模式的系统，标准绩效函数(Merit Function)无法被使用于优化，且瞳孔图(Pupil 

Mapping)将会失败。请查看光线扇形图(Ray Fan Plot)。 

 

 

 

优化将根据使用者自订的绩效函数，通常使用「暴力(Brute Force)」光线追迹。 

 



 

 

 

7-14 带状优化 

我们希望透镜的每个局部将能量聚集置成像面上的特定局部。如何达到呢？首先，定义局

部的表面孔径。在 LDE 插入新的表面 3、4 以及 5（因此成像面成为表面 6）。 

 

 开启表面 3 的表面属性对话框，并选择孔径页(Aperture Page)。设罝孔径型态为圆形挡板

(Circular Obscuration)（并非原形孔径），最小半径为 0.15 mm，最大半径为 0.35 mm。这将允许

离轴高度从 0.15 mm 至 0.35 mm 的光线通过。 

 

 

 

 

表面 4：孔径型态为圆形挡板，最小半径为 0.50 mm，最大半径为 0.70 mm。 

 



 

 

 

表面 5：孔径型态为圆形挡板，最小半径为 0.85 mm，最大半径为 1.05 mm。 

 

 

表面 6：孔径型态为圆形孔径（非挡板），最小半径为 0.00 mm，最大半径为 1.20 mm。 

 



 

 

 

7-15 目标局部 

这个目的是透过开启的局部，尽可能地让成像面上得到更多的能量。下面的阴影设计图

(Shaded Model Layout)将开启的局部以红色显示。 

 

 

 



 

 

 

 

7-16 光线目标 

存在有许多方案可以允许大量的能量通过开放的局部，我们使用其中一个能使穿越任一开

放局部的能量可到达相对应的成像面局部。我们可透过在绩效函数中新增目标(Target)设罝限制

条件，从每个透镜局部的入瞳(Entrance Pupil)中心追迹光线至成像面上相对映局部的中心。 

使用操作数 REAR(Real Ray Radial Height)： 

 在「Py」键入光线在瞳孔的归一化高度，第一个局部 2.5/19 = 0.13； 

 在「Target」键入成像面上想要的光线高度。 

 

 

 

7-17 系统性能 

接者加入操作数来控制到达侦察器的最大能量。IMAE(Image Analysis Efficiency)这个操作

 



 

数决定进入光学系统的光线到达特定表面（这个例子是指成像面）的百分比。 

 

在主菜单栏，选择 Analysis->Image Analysis->Geometric Image Analysis。可观察到非常少

的光线到达成像面，效率指示于视窗的 Text 按钮中。 

 

这个分析是基于蒙地卡罗分布的仿真，结果非常不明显。 

 

 

7-18 运行影像分析性能之优化 

开始定义优化所需的参数。首先，开启几何影像分析(Geometric Image Analysis)的对话框

并且点击「Save」。对这个例子而言，默认的参数是合适的，所以先保存参数设罝。 

 



 

 

在绩效函数中新增操作数 IMAE。 

 目标值：1.0 

 权值值：10 

透过此操作数可以控制所想要得到的能量。大于光线目标（被选取需解的局部）的权值，操作

数可以被插入 MFE 的任何地方。 

 

 

 

7-19 设罝变数 

优化所使用的变数为透镜的曲率半径。成像面的位置也可被使用为变数，我们将得到位置

为远离出瞳 100 mm。此外需要新增「空气」透镜的曲率半径为 Pick-Up 的解，以限制数值为

目前外部局部的曲率一致。 

 

在 NSCE 中，设罝对象 1、3、5 以及 7 的半径为变数。开始时所有局部使用 70 mm 的半

 



 

径。对象 2、4 以及 6 的半径 Pick-Up 到对象 1。 

 

 

 

7-20 最终设计 

现在可以开始透过我们自订的绩效函数来寻找最佳设计。绩效函数将追寻几何影像分析

(Geometric Image Analysis，(Ctrl + J))中设罝对话框的最大光线数目。使用这个自订的绩效函数

将比使用标准默认绩效函数花较多的时间。优化运算法则将持续计算至多次循环皆没有明显的

改变为止（小数点后第八位）。你可能需要单击结束按钮(Terminate Button)来停止优化。最后将

得到众多合理解决方案的其中之ㄧ。 

 

 



 

 

 

 

 

 

 



 

 

 



 

例子8 物理光学传播 (Physical Optics Propagation) 

 

8-1 物理光学传播 

在这个例子中，我们将设计一个简易系统以验证传播中的波前转换。首先设罝系统孔径的

类型为 EPD(Entrance Pupil Diameter)，且孔径尺寸为 10 mm。 

 

设罝系统波长为 1.0 μm。 

 

在 LDE(Lens Data Editor)中新增两个表面于光阑(Stop)之后。 

 



 

 

 

计算光束尺寸为 1 mm（A = 1 mm）的三阶、二阶以及一阶菲涅耳局部(Fresnel Zones)的距

离。 
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在 LED 中键入适当的距离（表面 2 为三阶菲涅耳局部，表面 3 为二阶菲涅耳局部，成像面为

一阶菲涅耳局部）。 

 

 

 

8-2 定义光线 

从 ZEMAX 的主菜单栏中选择 Analysis->Physical Optics->Physical Optics Propagation。 

 



 

 

在分析视窗内单击鼠标右键以开启设罝对话框。首先，选择一般(General)标签： 

 开始表面(Start Surface)：入瞳(Ent. Pupil)； 

 结束表面(End Surface)：成像面(Image)。 

 

接着，选择光束定义(Beam Definition)标签： 

 设罝 X-、Y-的采样(Sampling)为 256； 

 



 

 设罝 X-、Y-的宽度(Width)为 20； 

 选择「Top Hat」分布； 

 设罝 X、Y 的腰部(Waist)为 1。 

      

 

 

8-3 设罝显示参数 

最后，选择显示(Display)标签。设罝显示出 Cross X 的计算（Show As）；并点击「Save Beam 

At All Surfaces」这个选项（这个动作将使 ZEMAX 计算并且保存所有表面的资讯，所以在分析

其它表面时就不需要再次运行计算）。点击「OK」。 

 



 

 

 

 

8-4 一阶局部 

请观察辐射照度分布中的近轴峰值(On-Axis Peak)，这是奇数菲涅耳数值(Fn)的属性。这个

辐射照度的峰值约为初始强度的四倍，在与光束尺寸相近的距离上强度大约落在初始强度的

0.25 倍上（可搭配鼠标得到分析图表上的座标）。 

 



 

 

 

 

8-5 其它局部 

观察三阶以及二阶局部的辐射照度分布，请从 ZEMAX 的主菜单中选择 Analysis->Physical 

Optics->Beam File Viewer。在分析视窗内，单击鼠标右键来开启对话框中，首先选择文件

「Lens_0002.zbf」并且使用 Cross X 的显示类型。 

 

 

 



 

同样地，之后也可选择「Lens_0003.zbf」来观察三阶局部。 

 

 

 

8-6 辐射照度分布 

观察三阶菲涅耳局部，其分布有三个明显的峰值，最强的在轴上。 

 

在二阶局部，其分布有两个分离的峰值，且轴上强度为 0。 

 



 

 

 

  

 



 

 

 

第一章 

 

系统参数 
(System) 



 

Question 1： 

Lambertian scattering 参数的设罝？ 

 

Answer： 

兹说明步骤如下： 

1.首先，在 Spot Diagram Setting 的对话框中，您须把 Scatter Rays 勾选起来。 

 

 

2.其它对话框的勾选情形如下：（因您的版本较旧，故设罝上会略有不同。） 

 

 



 

 

 

 

3.输出情形如下列图示： 

 

 

 

如此一来，便可分析不同散射属性所呈现的图表。 

 

 



 

Question 2： 

如何将一均匀出光之点光源改为具有高斯能量分布之点光源？ 

 

Answer： 

您需在 System->General 的 Aperture 标签中，在 Apodization Type 的下拉式选单中，选择

Gaussian，而 Apodization Factor 为定义高斯的能量衰减因子。 

 

一般可依您的需求设 1~4 之间，不建议设罝大于 4 的值，因为这会造成采样的光线数太少

而无法计算出有意义的结果，您可参考 Samples\Sequential\Interconnects\Ball coupling.ZMX 的

ZEMAX 例子档。 

 

 

 

 



 

Question 3： 

如何将点光源更改为面光源(直径 0.02mm 之面光源)？ 

 

Answer： 

您需在 System->General 的 Aperture 标签中，在 Aperture Type 的下拉式选单中，将 Object 

Space NA 改为 Entrance Pupil Diameter，并在 Aperture Value 的栏中键入 0.02，最后还需将 OBJ

的 Thickness 改为 Infinity，表示光源为无穷远的平行光入射。 

 

 

 

 

 



 

Question 4： 

如果我想改变 NA，那我需要改变那些设置？ 

 

Answer： 

您要检查 NA 值（＝n × sinθ）和您现在用的 Laser 的偏角是否匹配，然后你在 General

中的 Aperture Value 键入您计算的数值。如果您的光线正常通过镜头，你不需要改变其它设置。  

 

 

 



 

Question 5： 

为何ZEMAX有时在Layout中所绘出的光线好像不正确；例如光线没有打到孔径光栏

(Aperture Stop)? 

 

Answer： 

大部分光线没有打到光栏或者光线追迹怪异的原因，是由于光栏表面设在 Coordinate Break

的表面之后。所以您必须避免将光栏设在 Coordinate Break 的表面之后。您可试着在 Coordinate 

Break 的表面之前插入一个哑表面，并将光栏设在此哑表面上。此外 ZEMAX 默认的 Ray Aiming

模式为「Off」，意指光线会往物方 Z 轴上的近轴入瞳追迹。假如您的系统有设罝一个实际的光

栏，您可以试着在 System->General 的对话框中，选择 Ray Aiming 模式为」On」。 

 

 

 



 

Question 6： 

在 ZEMAX 中，要如何利用 Telecentric Object Space 的功能选项来设罝系统为物方的远

心(telecentric)系统？ 

 

Answer： 

请按照以下步骤即可设罝完成： 

 

1. 设罝Surface Parameters 

 

 

2. 设罝物高为 5、0、-5 

 

 

3. 设罝光源 NA=0.1，并勾选 Telecentric Object Space 

 



 

 

 

4. 开启 2D 图表。 

 

 

 



 

Question 7： 

在ZEMAX中，请问为何红外线波段材料，如SILICON、GERMANIUM，在Glass Catalog

中为何没有显示Index值？ 

 

Answer： 

这是因为 ZEMAX 在 Glass Catalog 中所显示出的 Index Nd，Abbe Vd 是参考 d 光（0.587 

microns）以做为参考值，而红外线波段材料通常不包括此波段，故不会显示出 Nd，Vd 值。 

您可在 LDE 中的 Glass 栏键入红外线波段的材料名称，然后按下 Ctrl+Z，此时 ZEMAX 会

根据此材料所使用的方程式和您目前使用的波长来帮您换算出 Nd 值。 

 

1. 设罝所需的波段 

 

 

 

2. 键入所需的材料(SILICON) 

 



 

 

3. 在 Glass 栏上按下 Ctrl+Z，换算出 Nd 值。 

 

 

4. 根据 Glass Catalogs 推算 

 

 

 

 



 

 

Question 8： 

在 ZEMAX 中，可以在 OBJ 的表面上键入半高值(Semi-Diameter)吗? 

 

Answer： 

ZEMAX是以场点定义的对话框来设罝物体高度。所以要键入特定的物高，需在

System->Fields的对话框中做设罝。所以虽然ZEMAX可以在OBJ的表面上键入半高值，但并不

这样使用。 

 

 



 

 

Question 9： 

设罝所有 Free Space 的折射系数，也就除了 Lens Data 以外的空间，要如何设罝？因为在

General 里面我只找到设罝 Environment 的温度跟压力。 

 

Answer： 

ZEMAX 在 Sequential 模式中是以"表面"为单位，依序从光源到成像面去做光线追迹，所以

它并不去定义整个空间的折射率，而是当光线追迹到的表面是什么材料时，才去定义它的折射

率。您会发现 Glass 栏没有填玻璃型号时，表示为空气，所以光经过这个面时并不会发生偏折。 

 

而在 Non-Sequential 模式中是以"对象"为单位，为非序列性描光，此时就没有序列性描光

的问题，这个时候，您可以定义一个任意形状的物体，然后把它当作是装满水的水槽（材料名

称给 WATER），之后就可以在这个水槽里面建立光源对象、透镜对象、传感器对象...等，此时

空间的折射率即是 WATER，而空间范围即是这个水槽大小，然后光可以在这个物体空间范围

中做光线追迹。 

 

以上所述为 ZEMAX 在定义空间中之折射率的方法。 

 

 



 

Question 10： 

请问一下，ZEMAX 如何设罝背景周围的折射系数？ 

 

Answer： 

您只需要像填入玻璃材料的型号一样，在 Glass 栏中填入您的周围材料， 例如，您可以在

Tools->Catalogs->Glass Catalogs 中的 MISC.AGF 材料目录里找到 SEAWATER (海水), WATER 

(水),  VACUUM (真空)...等常见的背景周围折射率。 

 

 

 

 



 

Question 11： 

在 Zemax 中的 System->General 里，Aperture Type 中 Image Space F#以及 Paraxial 

Working F#，Manual 里的说明为：Paraxial Working F/#: The defined conjugate paraxial F/# in 

image space. Image Space F/#: The infinite conjugate paraxial F/# in image space.  

 

Answer： 

近轴工作F/#：共轭像方近轴F/# 

 

 

像方 F/#：与无穷远共轭的像方近轴 F/# 

 

 

 

 



 

Question 12： 

在 General 的 Gaussian factor 设为 4，LED 的光源分布状况是很相近，因此我设罝此条

件如下，这样是否正确？ 

 

 

 

Answer： 

这部分的设罝是 ZEMAX 的采样设罝，当使用 Gaussian 光束分布时，其光线采样分布为

A(r) = exp( -G × r 2 )。依据原厂建议，为避免采样数不足，G 值（Gaussian factor）设罝最好小

于 4。 

 

 



 

Question 13： 

在 LDE 里面发现可以针对 OBJ 设罝 Scattering, 且 LED 又是 lambertian 的光源格式, 但

里面有两个选项很类似一为 Lambertian/scatter fraction, 另一为 Abg/LAMP-SPEC, 要选哪一

样才是正确, 或是两者等同意义; 

 

      

 

Answer： 

此设罝是考虑表面散射部分，通常在鬼像分析时使用，所以在设罝 LED 光源不需要额外

进行设罝。 

 

 



 

Question 14： 

在 LDE 中，如何将平行光源入射改为点光源入射？ 

 

Answer： 

在 System->General 中，设罝标签 Aperture 中的 Aperture Type 为 Object Space NA，并在

Aperture Value 中设罝光源的发散角度。在 LDE 中，OBJ 的 Thickness 栏中不可为 Infinity。 

 

 

 

 

 



 

Question 15： 

在 ZEMAX 中，如何设罝小数点后的位数？ 

 

Answer： 

可以在 File->Preferences 中的标签 Editors 里设罝 Decimals，最多可以设到小数点后第 14

位数。 

 

 

 



 

Question 16： 

想自己设罝折射率要如何设罝，可以自行设罝新的透镜吗? 

如果我想将自己所设计的透镜组用图片来看其成像的结果，那我该如何做? 

 

Answer： 

1. 在ZEMAX中，要自行设罝折射率需要同时考虑色散，请依据The glass dispersion formulas

（Ref. CH18 USING GLASS CATALOGS），所以你还要给定一些参数才能设罝出特定折射率，

因此并不建议您采用此法，图示如下所示。 

 

 

 

Tools->Catalog->Glass Catalog 

 



 

 

 

 

2. 如采用以上方法就算能找到自己要的折射率，但却不是 lens 厂商所能提供的，所以建议能

采用以下方法： 

System->General->Glass Catalogs 

 

在上图中，您可多选取几家厂商以方便您找到所想要的 index，当然 cost 通常是需要考虑的。 

Analysis->Glass and Gradient Index->Glass Map 



 

 

Settings 

 

 

键入您要找寻的 index 范围 

 

3. 要看到自己所设计完成的光学系统成像，可使用 Analysis->Spot Diagrams->Standard。 

 

 



 

 

 

第二章 

 

表面型态 
(Surface types) 

 

 



 

Question 1： 

有一张数据图，内容是描述非球面镜的曲率变化，其中直线代表球面镜的曲率，起伏的曲

线代表非球面镜的曲率，X 轴代表径向座标，Y 轴代表曲率半径，如何根据这张图在 ZEMAX

中建构出非球面镜？ 

 

Answer： 

列出解的步骤供您参考： 

   

将标准球面的参考基准线向下移到非球面波形的谷点，这是为了以球面中心为 0 点时，来

做出非球面的曲率，所以大约取出三个点的相对差值方便后来的解过程，分别为 0.08333 um、

0.25 um、0.5 um (可以自行做修正 )。以下列出会使用到的方程式并提供求值的过程供您参考： 

 

 Co = 1/ R0 ~ 0.600081611 ( = 1/1.66644 ) 

 C1 = 1/ ( R1+ Delta R1) ~ 0.600051605  

 



 

 C2 = 1/ ( R2 + Delta R2 ) ~ 0.5999916 

 C3 = 1/ ( R3 + Delta R3 ) ~ 0.599901616 

 Z0 = C ( r ) ^2 / ( 1 + ( 1- (C r ) ^ 2 ) ^ 1/2 ) ~ 0.131307，0.072529，0.031838  

(分别带 r1, r2, r3 和 C1, C2, C3 的值) 

 Z1 = C1 ( r1 ) ^2 / ( 1 + ( 1- (C1 r1) ^ 2 ) ^ 1/2 ) ~ 0.124561 

 Z2 = C2 ( r2 ) ^2 / ( 1 + ( 1- (C2 r2) ^ 2 ) ^ 1/2 ) ~ 0.062721 

 Z3 = C3 ( r3 ) ^2 / ( 1 + ( 1- (C3 r3) ^ 2 ) ^ 1/2 ) ~ 0.024393 

      将以上的值带入下式非球面方程式解联立，来求出非球面系数 a2, a3, a4： 

Z = Z0 + a2 r ^4 + a3 r ^6 + a4 r ^8 

 => 0.124561 = 0.131307 + 0.176728 a1 + 0.074295 a2 + 0.031233 a3 

     0.062721 = 0.072529 + 0.055918 a1 + 0.013223 a2 + 0.003127 a3 

     0.024393 = 0.031838 + 0.011045 a1 + 0.001161 a2 + 0.000122 a3 

 

=> a1 = -1.313709338 ,a2 = 7.102007212 ,a3 = -9.676316755. 

  

把上面求出的解放到 ZEMAX 的 Even Asphere 中。 

 

 

最后，我取出非球面的中间行 Surface Sag 值与标准球面的中间行 Surface Sag 值相减以

Excel 绘图，可得 Sag 的曲线，大致可看出其与曲率的曲线相似，只需再做转换即可。 

 



 

 

  

您会发现，这里只取非球面系数的其中三项解，您也可以自行增加其它系数项来解，但是

要注意的一点，"三个变数要以三个方程式来解联立方能解"，建议您可以使用 Excel 或其它数

学工具来辅助解。 

 

 



 

Question 2： 

在 ZEMAX 中，光线在 3D Layout 图上好像会被移到旋转面镜(Fold Mirror)之后，然后反

射离开此一表面，再以正礭方向反弹离开这个面镜？ 

 

Answer： 

这是由于哑表面(Dummy Surface)以0厚度直接放在Coordinate Break的表面前所引起，

Coordinate Break表面是用来使旋转面镜倾斜。ZEMAX追迹光线到这个哑表面上，然后返回面

镜表面。当描绘表面和光线时，总是省略Coordinate Break表面。解决方法，设罝哑表面的半高

(Semi-Diameter)为0。或者，完全不使用哑表面。 

 

 

 

 



 

 

 

 



 

Question 3： 

在 ZEMAX 中，如何建构 Lens Array，仿真当光通过后所产生的影响？ 

 

Answer： 

1. Sequential Mode中，您可在 Surface Type的下拉式选单中，选择User Defined，然后在 Surface 

DLL 的下拉式选单中，选择 EVENARRY.DLL 或 US_ARRAY.DLL 即可快速建立，详细内

容请参阅 Manual CH11 SURFACE TYPES 的 User Defined 的 Lenslet arrays using UDS 

DLLs。 

 

2. Non-sequential mode 中，则要利用 CAD 软件先建构好 lens array，然后保存成 IGES 档，再

Import 至 ZEMAX 中。 

 

 

 



 

 

Question 4： 

为何在ZEMAX中建立系统参数时，在表栏编辑器上会出现星号呢? 

 

Answer： 

通常在 LDE ( 透镜资料编辑栏 ) 中，星号会出现在 Surface Type 的序列编号上，这表示

您有定义表面的 Aperture 性质或者您有自行定义 Semi-Diameter 的大小，而在 MCE ( 多组态编

辑器 ) 中，星号会出现在 Config 的多组态编号上，这表示是正在此结构状态下进行编辑。 

 



 

Question 5： 

在使用 ZEMAX 进行设计时，选用 GRID SAG 面型，在 EXTRA DATA 中怎么进行所需

参数的设置，为何在 IMPORT 时总会出现一个资讯：GRID FILES MUST HAVE AN ODD 

MUMBER OF ROWS AND COLUMNS？ 

 

Answer： 

在 Grid Sag 这种 Surface Type 的参数设罝需在 ZEMAX/GRIDSAMP.C 中去做 Modify，然

后再利用 Visual C++去建立出"GRIDSAMP.DAT"，之后再到 Extra Date Editor 中，做

Tools->Import 选择 GRIDSAMP.DAT 的动作即可。 

 

Grid files must have an odd number of rows and columns! 的错误信息是因为 nx 与 ny 的点数

目要是奇数且不得小于 5，相关例子在 ZEMAX\Samples\Sequential\Miscellaneous\Grid sag 

surface.ZMX，此例的 Grid Sag 为建立一球面，您可以 Notepad 即可开启 ZEMAX/GRIDSAMP.C

来参考所需的参数设罝，此外请参考 Manual 中 Chapter 11 SURFACE TYPES 的 Grid Sag 的参

数定义。 

 

 



 

 

Question 6： 

请问在ZEMAX的Sequential模式下，要如何建构Lenticular这个组件? 

 

Answer： 

您可以在Surface Type的下拉式选单中，选择User Defined的表面型态，然后在Surface DLL的下

拉式选单中，选择US_CYLAR.DLL来建构Lenticular这个组件。 

 

 



 

 

Question 7： 

在设罝User Defined的US_MEMS.DLL时，在3D Layout中却看不出有角度的旋转，该如

何确认参数键入有无错误呢? 

 

Answer： 

您可先到 Non-Sequential Mode 中，在 NSC Editor 的 Object Type 中，选择 MEMS，即可出

现和您在 Sequential Mode 中的 US_MEMS.DLL 相对应的参数键入表栏置，然后再键入相同参

数，并开启 NSC 3D Layout，即可看出有角度的旋转，以此做确认，再到 Sequential Mode 中使

用，设罝即可正确无误。 

 



 

Question 8： 

在ZEMAX中，对于二元光学的表面Binary 2，需要在额外资料编辑栏(Extra Data Editor, 

EDE)的Norm Radius(normalization radius)栏中(单位为mm)填入什么? 

 

Answer： 

100 mm 为默认的正规化曲率，然而，这个值并不预期使用在所有的设计。此正规化曲率

可以设罝成任何适当的值，只要符合相位系数的规定。表面上的相位定义为正规化曲率的函数，

ρ。假如改变正规化曲率，则必须调整相位系数以便在表面上取得相同的相位。此正规化值通

常设罝为与表面的半高(semi-diameter)相等，或为 1 的值。假如设为与半高相等，所有项次的

相位系数总和将适当的在边缘部分给定总相位，相位方程式中所有ρ的次方是等于 1。若正规

化曲率设罝为 1，ρ将以透镜的单位来刻化，可能也适当计算相位当成表面座标的函数。 

 

 

 

 



 

Question 9： 

在 ZEMAX 中，手册 Chapter 11 SURFACE TYPES 中的 Standard 有提到关于扁椭圆面

(Oblate Ellipsoid)，请问什么是扁椭圆面(Oblate Ellipsoid)? 

 

Answer： 

在几何中，它是藉由旋转一椭圆的短轴(Minor Axis)所形成的一个旋转表面，产生一个具有

构成圆的焦点位置的扁椭球体(Squashed Spheroid)。在ZEMAX中，这样的表面为一旋转对称

(Rotationally Symmetric)的表面，是藉由标准面(Standard Surface)的弯陷方程式(Sag Equation)，

以圆锥常数(Conic Constant)大于0来表示。较常使用的有球面(Spheres)、双曲面(Hyperbolas)、

抛物面(Parabolas)和椭圆面(Ellipses)；皆是藉由圆锥常数(Conic Constant)小于0或等于0来定义。 

 

 

 



 

Question 10： 

当我在非序列模式中仿真光打在 White Paper 上的散射。设罝"Rectangle"仿真 Whit 

Paper，将"Rectangle"的材料设为 MIRROR，"Rectangle"的属性设罝如下图，请问 Paper 的

设罝是正确的吗？或者是作其它的设罝，如：Coating。 

 

 

Answer： 

关于 White Paper，当入射角不大时，郎伯（Lambertian）是相当正确的。但大的入射角（80

度或更高），表面有一些反射的组件在散射。小的入射角时，White Paper 的郎伯是正确的。 

 

 

 



 

Question 11： 

当我在非序列模式中仿真光照射在 White Paper 上的散射。设罝"Rectangle"仿真 Whit 

Paper，将"Rectangle"的材料设为 MIRROR，"Rectangle"的属性设罝如下图，当其它光源打

在"Rectangle"时，我发现所有的能量被散射，没有能量被"Rectangle"吸收，在真实的情况有

70%会被散射，一些被 Paper 吸收，请问我该怎么仿真呢？ 

 

Answer： 

使用者仍然需要从表面的总散射去决定多少的能量会被吸收。将表面设为 MIRROR，所以

表面会反射，但加 I.50的Coating上去，表面将会反射50%的能量。设罝1.0的Scatter Fraction，

代表每一光线将会散射，选择10条光线去散射，每一条光线都会在表面反射。由此可知，Coating

在散射中是占很重要 

 

 

 



 

 

Question 12： 

在 ZEMAX 中，可以在 IMA 的表面上键入厚度值(Thickness)吗? 

 

Answer： 

ZEMAX 使用的厚度规定为某一个表面到下一个表面间的距离。既然 IMA 表面为最后一个

表面，所以没有下一个表面。虽然有一些软件使用这个表面上的厚度当成离焦(defocus)的栏，

但 ZEMAX 并不这样使用。理由主要在维持表面间的独立，因为 ZEMAX 并没有强制 IMA 表

面在刚开始一定是在近轴聚焦位置。使用离焦的栏并没有意义的原因是，我们可在 IMA 表面

之前插入一个哑表面来代替这个栏的功能。 

 



 

Question 13： 

当我在 SC 的编辑下 Insert NS Component 后，NSC 似乎只是出现在 Layout 之中，光路

Tracing 并没有受到影响，我该如何做才能将 NSC 及 SS 系统一起分析呢..? 还是 ZEMAX 无

法做到这样的分析? 

Answer： 

由您字面上所描述的问题，主要原因是因为您在使用 Mixed Mode (即 NSC with ports) 时，

设罝 NSC 对象的边界有误，所以才会造成 Layout 中看的到 NSC 对象，但却无法正确描光。您

可以参考 ZEMAX 的例子，以便了解 Mixed Mode 的设罝方式，文件路径在

Samples->Non-sequential->Miscellaneous->Demo 1.ZMX 和 Demo 2.ZMX。 注意，您可以在选定

为 Non-Sequential Component 的表面栏上，找到一栏为 Draw Ports?的栏，然后把"0"改"3"，即

可看到您所设罝的 NSC 边界范围。 

 

 

 

Draw Ports?

NS

C 

Entry 

Exit Port 

 



 

 

Question 14： 

在 ZEMAX 中，由于内建的 Diffractive Grating Surface 其周期是固定的，若想要设计的

Grating 其周期大小是会变化的该怎么设计？ 

 

Answer： 

因为 ZEMAX 内定的 Grating 皆为周期性的，所以您若要设计非周期性的 Grating，则必须

以 C 语言自行建构，以 Dos 版的 Turbo C\C++软件即可以进行 Compile，并不需使用到 Windows

版的 C\C++软件，至于建构方式可以参考文件 ZEMAX\DLL\US_GRATE.C。其程序如下所示： 

#include <windows.h> 

#include <math.h> 

#include <string.h> 

#include "usersurf.h" 

/* 

Written by Kenneth E. Moore 

Oct 11, 1996 

 

Modified by KEM August 18, 1998 to fix OPD bug if incident medium is not air. 

*/ 

 

int __declspec(dllexport) APIENTRY UserDefinedSurface(USER_DATA *UD, FIXED_DATA *FD); 

 

/* a generic Snells law refraction routine */ 

int Refract(double thisn, double nextn, double *l, double *m, double *n, double ln, double mn, 

double nn); 



 

 

 

BOOL WINAPI DllMain (HANDLE hInst, ULONG ul_reason_for_call, LPVOID lpReserved) 

 { 

   return TRUE; 

   } 

 

/* this DLL models a "diffraction grating" surface type, either plane, sphere, or conic */ 

 

int __declspec(dllexport) APIENTRY UserDefinedSurface(USER_DATA *UD, FIXED_DATA *FD) 

 { 

   int i; 

   double p2, alpha, power, a, b, c, rad, casp, t, zc; 

   double nx, ny, nz, M, L, T, ux, uy, uz, dpdx, dpdy, nn; 

   switch(FD->type) 

    { 

      case 0: 

       /* ZEMAX is requesting general information about the surface */ 

         switch(FD->numb) 

          { 

            case 0: 

             /* ZEMAX wants to know the name of the surface */ 

           /* do not exceed 12 characters */ 

           strcpy(UD->string,"Grating Dll"); 

               break; 



 

 

            case 1: 

             /* ZEMAX wants to know if this surface is rotationally symmetric */ 

               /* it is not, so return a null string */ 

             UD->string[0] = '\0'; 

               break; 

            case 2: 

             /* ZEMAX wants to know if this surface is a gradient index media */ 

               /* it is not, so return a null string */ 

             UD->string[0] = '\0'; 

             break; 

            } 

         break; 

      case 1: 

       /* ZEMAX is requesting the names of the parameter columns */ 

         /* the value FD->numb will indicate which value ZEMAX wants. */ 

         /* they are all "Unused" for this surface type */ 

         /* returning a null string indicates that the parameter is unused. */ 

         switch(FD->numb) 

          { 

            case 1: 

             strcpy(UD->string,"Lines/Micron"); 

               break; 

            case 2: 

             strcpy(UD->string,"Order"); 



 

 

               break; 

            default: 

             UD->string[0] = '\0'; 

             break; 

            } 

       break; 

      case 2: 

       /* ZEMAX is requesting the names of the extra data columns */ 

         /* the value FD->numb will indicate which value ZEMAX wants. */ 

         /* they are all "Unused" for this surface type */ 

         /* returning a null string indicates that the extradata value is unused. */ 

         switch(FD->numb) 

          { 

            default: 

             UD->string[0] = '\0'; 

             break; 

            } 

       break; 

      case 3: 

       /* ZEMAX wants to know the sag of the surface */ 

         /* if there is an alternate sag, return it as well */ 

         /* otherwise, set the alternate sag identical to the sag */ 

         /* The sag is sag1, alternate is sag2. */ 

 



 

 

         UD->sag1 = 0.0; 

         UD->sag2 = 0.0; 

 

   /* if a plane, just return */ 

   if (FD->cv == 0) return(0); 

         p2 = UD->x * UD->x + UD->y * UD->y; 

         alpha = 1 - (1+FD->k)*FD->cv*FD->cv*p2; 

         if (alpha < 0) return(-1); 

         UD->sag1 = (FD->cv*p2)/(1 + sqrt(alpha)); 

         if (alpha != 1.0) UD->sag2 = (FD->cv*p2)/(1 - sqrt(alpha)); 

       break; 

      case 4: 

       /* ZEMAX wants a paraxial ray trace to this surface */ 

         /* x, y, z, and the optical path are unaffected, at least for this surface type */ 

         /* for paraxial ray tracing, the return z coordinate should always be zero. */ 

         /* paraxial surfaces are always planes with the following normals */ 

 

   /* for paraxial ray tracing, grating effects are ignored */ 

         /* this is exactly like the standard surface code */ 

         UD->ln =  0.0; 

         UD->mn =  0.0; 

         UD->nn = -1.0; 

         power = (FD->n2 - FD->n1)*FD->cv; 

         if ((UD->n) != 0.0) 



 

 

          { 

            (UD->l) = (UD->l)/(UD->n); 

            (UD->m) = (UD->m)/(UD->n); 

 

            (UD->l) = (FD->n1*(UD->l) - (UD->x)*power)/(FD->n2); 

            (UD->m) = (FD->n1*(UD->m) - (UD->y)*power)/(FD->n2); 

 

            /* normalize */ 

            (UD->n) = sqrt(1/(1 + (UD->l)*(UD->l) + (UD->m)*(UD->m) ) ); 

            /* de-paraxialize */ 

            (UD->l) = (UD->l)*(UD->n); 

            (UD->m) = (UD->m)*(UD->n); 

            } 

         break; 

      case 5: 

       /* ZEMAX wants a real ray trace to this surface */ 

         if (FD->cv == 0.0) 

          { 

          UD->ln =  0.0; 

          UD->mn =  0.0; 

          UD->nn = -1.0; 

      if (Refract(FD->n1, FD->n2, &UD->l, &UD->m, &UD->n, UD->ln, UD->mn, 

UD->nn)) return(-FD->surf); 

            } 



 

 

         else 

          { 

          /* okay, not a plane. */ 

    a = (UD->n) * (UD->n) * FD->k + 1; 

    b = ((UD->n)/FD->cv) - (UD->x) * (UD->l) - (UD->y) * (UD->m); 

    c = (UD->x) * (UD->x) + (UD->y) * (UD->y); 

    rad = b * b - a * c; 

    if (rad < 0) return(FD->surf);  /* ray missed this surface */ 

    if (FD->cv > 0) t = c / (b + sqrt(rad)); 

    else           t = c / (b - sqrt(rad)); 

    (UD->x) = (UD->l) * t + (UD->x); 

    (UD->y) = (UD->m) * t + (UD->y); 

    (UD->z) = (UD->n) * t + (UD->z); 

    UD->path = t; 

    zc = (UD->z) * FD->cv; 

    rad = zc * FD->k * (zc * (FD->k + 1) - 2) + 1; 

    casp = FD->cv / sqrt(rad); 

    UD->ln = (UD->x) * casp; 

    UD->mn = (UD->y) * casp; 

    UD->nn = ((UD->z) - ((1/FD->cv) - (UD->z) * FD->k)) * casp; 

          if (Refract(FD->n1, FD->n2, &UD->l, &UD->m, &UD->n, UD->ln, UD->mn, 

UD->nn)) return(-FD->surf); 

            } 

         /* okay, now account for the grating */ 



 

 

         /* the grating affects both the refraction angle and the phase, or OPD, of the ray */ 

         T = FD->param[1]; 

         M = FD->param[2]; 

         L = FD->wavelength; 

 

   /* here is the phase & phase change */ 

         /* the ZEMAX convention is we subtract out the positive phase...*/ 

         /* the index of the incident medium must be divided out because ZEMAX will 

         multiply in the index to convert path to optical path! */ 

         UD->path += UD->y*M*T*L / FD->n1; 

   dpdx = 0.0; /* included here only for extension to the general case */ 

         dpdy = M*T*L; 

 

         /* this is a generic vector diffraction routine more or less from Welford */ 

         /* if you do not understand how it works, see Welford, don't call me! *. 

 

         /* account for possible change in index or mirrors */ 

   dpdy /= fabs(FD->n2); 

         if (FD->n1*FD->n2 < 0) dpdy = -dpdy; 

   if (FD->n1 < 0) nn = -1.0; 

   else nn = 1.0; 

 

         nx = -UD->ln; 

   ny = -UD->mn; 



 

 

   nz = -UD->nn; 

 

   ux = UD->l + nn * (dpdx); 

   uy = UD->m + nn * (dpdy); 

   uz = UD->n; 

 

   rad = nx*ux + ny*uy + nz*uz; 

   rad = 1.0 - (ux*ux + uy*uy + uz*uz) + rad*rad; 

   if (rad <= 0.0) rad = 0.0; 

   else rad = sqrt(rad); 

   UD->l = ux - (nx*ux + ny*uy + nz*uz)*nx + nx * rad; 

   UD->m = uy - (nx*ux + ny*uy + nz*uz)*ny + ny * rad; 

   UD->n = uz - (nx*ux + ny*uy + nz*uz)*nz + nz * rad; 

         break; 

      case 6: 

       /* ZEMAX wants the index, dn/dx, dn/dy, and dn/dz at the given x, y, z. */ 

         /* This is only required for gradient index surfaces, so return dummy values */ 

         UD->index = FD->n2; 

         UD->dndx = 0.0; 

         UD->dndy = 0.0; 

         UD->dndz = 0.0; 

       break; 

      case 7: 

       /* ZEMAX wants the "safe" data. */ 



 

 

         /* this is used by ZEMAX to set the initial values for all parameters and extra data */ 

         /* when the user first changes to this surface type. */ 

         /* this is the only time the DLL should modify the data in the FIXED_DATA FD structure 

*/ 

         for (i = 1; i <= 8; i++) FD->param[i] = 0.0; 

         for (i = 1; i <= 200; i++) FD->xdata[i] = 0.0; 

         break; 

      } 

   return 0; 

   } 

 

int Refract(double thisn, double nextn, double *l, double *m, double *n, double ln, double mn, 

double nn) 

{ 

double nr, cosi, cosi2, rad, cosr, gamma; 

if (thisn != nextn) 

 { 

 nr = thisn / nextn; 

 cosi = fabs((*l) * ln + (*m) * mn + (*n) * nn); 

 cosi2 = cosi * cosi; 

 if (cosi2 > 1) cosi2 = 1; 

 rad = 1 - ((1 - cosi2) * (nr * nr)); 

 if (rad < 0) return(-1); 

 cosr = sqrt(rad); 



 

 

 gamma = nr * cosi - cosr; 

 (*l) = (nr * (*l)) + (gamma * ln); 

 (*m) = (nr * (*m)) + (gamma * mn); 

 (*n) = (nr * (*n)) + (gamma * nn); 

 } 

return 0; 

} 



 

Question 15： 

在 ZEMAX 中，有无 MEMS 的例子，Manual 中的说明在那里呢？ 

 

Answer： 

Sequential 的例子在 ZEMAX\Samples\Sequential\Miscellaneous\MEMS DLL Sample.ZMX。

Non-sequential 的例子在 ZEMAX\Samples\Non-sequential\Faceted objects\MEMS device.ZMX。请

参考 Manual 中 Chapter 11 SURFACE TYPES 的 User Defined/Sample DLLs 

 

 

 

 

 

也可参考 ZEMAX Manual 的 Chapter 12 NON-SEQUENTIAL COMPONENTS 的 NSC Objects，

MicroElectroMechanical System (MEMS)。 

 



 

 

 

 



 

Question 16： 

可否在 ZEMAX 已建立之一个聚焦透镜系统仿真，若透镜某一局部(成像侧)遭遮蔽(即无法

透光，此遮蔽局部可能在 Lens 表面或光传递路径上，而此局部之大小可由使用者设罝)，则聚

焦系统之焦点能量变化为何? 

 

Answer： 

ZEMAX 可以建立聚焦透镜系统。其中，可以在透镜面上或另外建一表面上来做 Coating

并 Define 表面透光量，也就是您所想要的透镜某一局部(成像侧)遮蔽，而且也可以设罝使用者

所需 Surface 大小。至于焦点能量变化如何，可以利用 Analysis->Illumination->Relative 

Illumination 来针对所要表面观察其相对照度分布。 

 

 

 



 

 

Question 17： 

我在 TracePro 中建立一个 LED 面发光源 (利用 SURFACE 建立角度对强度的关系)，我

想为这个特定的光源设计一个准直透镜，不知是否能将这光源设罝到 ZEMAX 中? 

 

Answer： 

序列性模式使用理想的点光源，所以面光源时不能优化透镜。 



 

 

第三章 

 

对象型态 
(NSC Objects) 



 

Question 1： 

Fiber 与 Fiber 间的间距最小可到多少? 127um 的间距做的到吗? 

 

Answer： 

可由例子 Sample\Non-sequential\Fibers\Core clad fiber.zmx 去改。在这个例子中，可多建一

个 fiber 在原 fiber 的上面，光路暂不讨论，Y Position 设为 6.127mm 以符合 127um 的需求，所

以要求是可行，至于最小可到多少，ZEMAX 在透镜编辑栏(LDE)中，可显示的 Decimals 的最

小位数为 14 位，可依此为参考依据，基本上这个 budget 应可符合您的各种需求。最大可显示

的 Decimals 可在 File\Preferences\Editors 中的 Decimals 的下拉式选单中去选择。 

 

 

 



 

Question 2： 

Core，cladding 可设罝不同大小吗? 

 

Answer： 

在改建的这个 Sample 中来看，core 与 cladding 的折射率不同是利用选择不同玻璃材料的

方式，core 是 K5，折射率为 1.52249，cladding 是 FK3，折射率是 1.4645。 

 

 

 

 



 

 

Question 3： 

在ZEMAX中，若要定义NSC的Fresnel对象，请问有无相关例子可供参考? 

 

Answer： 

关于定义 NSC 的 Fresnel 对象，ZEMAX 本身有提供一些既有例子，路径在

Samples->Non-sequential->Faceted object，目前共有 5 个相关文件可供参考，分别为：Fresnel lens 

cylinder structure.zmx、Fresnel lens from table.zmx、Fresnel lens ideal.zmx、Fresnel lens radial 

structure.zmx、Fresnel lens unfaceted table.ZMX。 

 



 

 

Question 4： 

在 ZEMAX 中，有无 MEMS 的例子，Manual 中的说明在那里呢？ 

 

Answer： 

Sequential 的例子在 ZEMAX\Samples\Sequential\Miscellaneous\MEMS DLL Sample.ZMX。

Non-sequential 的例子在 ZEMAX\Samples\Non-sequential\Faceted objects\MEMS device.ZMX。 

 

请参考 Manual Chapter 11 SURFACE TYPES/User Defined/Sample DLLs 及 Chapter 12 

NON-SEQUENTIAL COMPONENTS/MicroElectroMechanical System (MEMS) 。 

 

 



 

Question 5： 

请问如何设罝光学系统中的等腰直角棱镜？ 

Answer： 

建议您可以在 NSC Editor 的 Object Type 中（以 NSC with Ports 或 NSC without Ports 的方

式），选用 Poly Object，然后在 Data File 中选用 PRISM45.POB，即可选用等腰直角棱镜，然后

可在表栏里键入座标 X, Y, Z 的位置，倾斜和对象的放大因子（Scale）等。 

 

 

 



 

Question 6： 

使用Illumination/Illumination 2D surface时，出现一个错误信息"CANNOT COMPUTE 

RELATIVE ILLUMINATION ACCURATELY"，请问一下是什么问题？ 

 

Answer： 

ZEMAX 中，没有特定分析损失或百分比的功能，但若您在 Sequential Mode 下， Analysis

的功能中，您可以选用 Illumination->Illumination 2D surface 

 

 

 

 

 

 

或 Image Analysis->Geometric Image Analysis 来帮助您分析光线追迹到各组件表面的照明

情形，依您设的光线数来估算光线追迹到任何面时的光功率损失。 

 

 



 

 

 

相同地，若您在 Non-sequential mode 下，就变成是观测 Detector 上的光功率照明。 

 

 



 

 

Question 7： 

我想询问一下 ZEMAX功能中的Nonsequential 成像能量及绕、散射分析与TrasPro 和

ASAP 的分析功能有什么不同? 

 

Answer： 

以下是 ZEMAX 在使用 NSC 的优缺点供您参考，您若能善用其优点，应该可发挥其功能

性： 

 

缺点： 

1. 读进 CAD 文件时，若有破洞的产生，因不具有修补功能，所以光线追迹会有问题。但一

般若是以 ZEMAX 本身所提供的 Object 来建立模型，则不会此问题产生。 

2. 读进 CAD 文件时，会把所有的 Object 视为同一个 Object。换句话说，若 3 片 Lens 视为同

一个 Objects，则不同表面的 Coating 则无法个别应用，造成分析上会有问题产生。若一片

一片 Imported，则可改善此问题。 

3. ZEMAX 的 NSC 功能仅具有照度图，一般在光机软件内所在意的坎德拉图，则没有提供，

所以分析上会较困难，尤其要对 LED 的配光曲线时。目前尚无烛光图。 

 

优点： 

1. 当系统不大时，可利用 NSC 的光线追迹方式快速获得照度结果。 

2. 可对栏运行优化。即可对 Object 的参数栏运行优化并找出最佳值。 

3. 具有混合模式(Mixed Mode)，若您在做 SC 描光时，遇到像 Prism 或 Lens Array...等类型的

任意几何形状大小或排列的对象，则可透过 NSC 来定义，以便做正确光路的分析(传统是

用 Coordinate Break 表面或 Multi-Configuration Editor 来帮助建立模型) 

 



 

 

Question 8： 

若在设计仿真中仅需要观察照度资讯，而不需要烛光资讯，那我是否能用ZEMAX NSC模

式下仿真获得?或者还需使用TracePro进行仿真，Zemax NSC 仿真所得之值可靠吗?还是您会

建议有关能量分布之相关仿真，尽量使用TracePro 进行以得较精确之答案... 

 

Answer： 

基本上，Lens Design 部份使用 ZEMAX，杂散光分析或整个光机建立模型的后段光路仿真

使用 TracePro。您会发现 TracePro 可以 Import ZEMAX 设计完后的镜头和 CAD 画完的机构，

再键入光学属性和设罝光源后，便可进行能量的照度分析。ZEMAX 的 NSC 计算的数值会有一

定的准确性，至于与 TracePro 相比，目前并未进行这样的比较。 

 

 



 

 

Question 9： 

如何在一surface上 (物镜)，设罝不同的曲率(中心与周边)，使两束光源(同轴，但

semi-diameter不同)有不同的聚焦点，例如双波长读取头(DVD CD)共享一物镜， 但其聚焦点

相差0.6mm，是否有相关的example，或是在操作上该如何设罝? 

 

Answer： 

可以建立二个重合的面，透镜的里面一部分用圆形 aperture，外面一部分用环形的 aperture

实现这种结构。 

 



 

Question 10： 

如何从其它软件 IMPORT 对象到 ZEMAX？ 

 

Answer： 

若您要从其它 CAD 软件 import 您的 Object Type，您需先将 CAD 程序存成，IGES、SAT、

STEP 中任一种格式，即副档名为 IGS、IGES、SAT、STP、STEP 中的任一种，之后将您的文

件放到 Zemax\Objects 的文件夹内，开启 ZEMAX，您在 Object Type 选择"Imported"，在 Data File

的下拉式选单中，即可看到您的 CAD 档名。 

 

 

 

 



 

 

Question 11： 

请问 ZEMAX 是否可以仿真 HID 灯的配光曲线? 

 

Answer： 

1. ZEMAX 可以 Source DLL 的方式来仿真 HID 灯的配光曲线，方法是您必需要把配光曲线

写成 DLL 的光线座标格式，但若无法确切的以数学式描述光线追迹时的机率函数 

( probability function ) 时 ( 因为 Non-Sequential mode 是以 Monte Carlo 的方式做光线追

迹 )，在定义光线追迹的问题上将会很复杂，您可以参考 ZEMAX 路径的 Objects 下 DLL

资料夹内 Sources 中的 fiber1.c 的标准例子程序，来学习如何撰写 source code。 

 

2. 您可以 Source File 的方式从灯源数据库软件，如 Radiant Imaging 的 ProSource 来取得 HID

的配光曲线，并转成 ZEMAX 的格式 ( 这家公司可以付费的方式帮您量测出光源的配光

曲线 )。 

  

以上两点为 ZEMAX 在支持其它光源上的方式，提供您做参考。 

 

 



 

 

Question 12： 

在 ZEMAX 中，NSC 对象的折射系数分布是否能如 Surface Types 里面的 Gradient3 一样，

可以随着轴向分布？ 

 

Answer： 

在 NSC 中，您仍然可以选用 Gradient 3，不过它不在 Object Type 中，您需在 Object Type

上按右键，然后选择 GRIN 的标签，勾选 Use DLL defined GRIN media，然后在 DLL 的下拉式

选单中选择 GRIN3.DLL，之后您会发现下方系数栏中会出现如同 Surface Type 中 Gradient 3 的

系数，您只要将 NSC 系数设成与 SC 一样就会达成您想要的轴向分布。 

 



 

 

Question 13： 

在 ZEMAX 中，请问如何在 NSC with Ports 的方式下，看到 NSC 的 Ports 设罝范围，以

方便检示定义的边界范围？ 

 

Answer： 

您只需到 Lens Data Editor 中的 NSC Surface Type 中，在 Draw Ports 的栏中键入"3"，即可

显示 Ports 的边界范围。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 



 

 

 

第四章 

 

分析 
(Analysis) 

 



 

 

孔径光栏 

Question 1： 

如何设计球面镜射之离心孔径? 

 

 

 

 

 

 

 

 

Answer： 

透过 Coordinate Break 可以设罝离轴座标。如下图所示，在欲离轴的表面（群）前后加入

表面型态为 Coordinate Break 的表面，并设罝欲离轴的程度，即可于轴对称系统中加入离轴系

统。 

 



 

 

  

 

 



 

Question 2： 

如何设计倾斜的球面镜射? 

 

 

 

 

 

 

 

Answer： 

透过 Coordinate Break 可以设罝倾斜座标。如下图所示，在欲倾斜的表面（群）前后加入

表面型态为 Coordinate Break 的表面，并设罝欲倾斜的程度，即可于轴对称系统中加入倾斜系

统。请注意倾斜与位移（离轴）的先后顺序。 

 

 

 



 

 

 



 

Question 3： 

如何设计倾斜光束射入球面中心? 

 

 

 

 

 

 

 

Answer： 

请参照离轴设罝，搭配 Feld Angle 的设罝，即可设计倾斜光束。 

 

 

 



 

 

 

 

 



 

Question 4： 

关于在 Analysis 选项中的 Spot Diagrams 的各项数值，对于摄影物镜和望远系统有什么差

别吗，另外我设计的摄影物镜，该项中的 standard 的几个数值都比较大（参见附件），是不是

设计的系统没有达到优化值呢。以及关于 Spot Diagrams 的各项值对于镜头的具体含义为何? 

 

Answer： 

Zemax 中在 Analysis 选项中的 Spot Diagrams 的各项数值，对于摄影物镜和望远系统中的

意义有些不同，因为望远系统中是平行光出射，所以需要用 paraxial 面将它聚焦以后才能评价

这个指标。 从您的结果看，RMS radius 的值还有些偏大，可以再进行一些优化处理。因为不

同系统的要求不一样，所以这个值的具体大小如何才算合格没有统一的标准。 

 

 

 

 



 

Question 5： 

我将透镜的 Semi-diameter 固定，最边缘的光线就断掉了，如何挽救？ 

 

 

 

 

 

 

 

 

 

Answer： 

可透过 Field Data 中的 Set Vig 修正边缘光线。 

 

 



 

 

 

 

 



 

Question 6： 

这里有 u-透镜的抛物线资料，如果 H = height 和 W = width of the u-lens、Rc = radius、Rc 

= (H^2 + D^2/4)/2H、C = curvature = 1/Rc，指定 conic = -1，我提供的资料很接近吗？ 

 

Answer： 

我已经使用 ZEMAX 完成你的问题，我用"z=c * r^2 / (1+(1-(1+k) * c^2 * r^2)^1/2)"方程式去

解 c，我获得 R = 1 / c ~ 2.188。我也用 Excel 检查 ZEMAX 的资料，我发觉数值非常的接近，

所以我认为你可以使用这些数据。 

 

 



 

 

 



 

Question 7： 

当我在 S 的编辑下 insert NS component 后，NSC 似乎只是出现在 layout 之中，光路 tracing

并没有受到影响，我该如何做才能将 NS 及 S 系统一起分析呢? 还是 ZEMAX 无法做到这样的

分析？ 

 

Answer： 

由您字面上所描述的问题，主要原因是因为您在使用 Mixed Mode (即 NSC with ports) 时，

在设罝 NSC 对象的边界有误，所以才会造成 Layout 中看的到 NSC 对象，但却无法正确描光。 

您可以参考 ZEMAX 的例子，以便了解 Mixed Mode 的设罝方式，文件路径在 

Samples...Non-sequential...Miscellaneous...Demo 1.ZMX 和 Demo 2.ZMX。 

注意，您可以在选定为 Non-Sequential Component 的表面栏上，找到一栏为 Draw Ports?的栏，

然后把"0"改"3"，即可看到您所设罝的 NSC 边界范围。 

 

Question 8： 

如何修正此 Laser System 的 red beam? 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

Answer： 

从*Red beam.ZMX*的文件得知，光线不能打在你所设的 MIRROR 上。 

所以你必须清楚了解如何何设罝 Coordinate Break。 

1)因为您光路中的部分边缘光线跑掉了，所以我对您的文件做了修正，我相信这样的结果会比

较好。 

2)我发现您在视角设罝中，勾选了全部的视角，我觉得这是不必要的，所以我仅帮您留下一个

视角。 

 



 

 

 

 

 

 



 

Question 9： 

Zemax的 Huygens PSF是直接将光的波前迭加来做计算，并不会用到之前计算所用的近似，

所以 Huygens PSF 应该是适合来做高 NA 值物镜 PSF 的计算。 现在的问题就是如何能直接看

Z 轴上的强度分布图? 

 

Answer： 

ZEMAX 所提供的命令尚无法直接抓出 PSF 的 Peak 值，所以您务必要点击 Huygens PSF

的图表分析功能上的 Text 钮，以便列出详细数值资料，然后再 Copy 到 Excel 中绘图。请参考

如下： 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 



 

Question 10： 

PSF 与 POP 不同结果是一个问题，另一个问题是 POP 得到的结果是不太正确，而且 size

跟实际实验值不太一样，该如何调整?  

 

Answer： 

我仍然觉得原因是出在"aliasing"(失真)，我了解您所使用的雷射光源为半角 X=13.43，

Y=7.36，但就您目前的镜头来说，其光源实际上可入射的半角约为 4.477122922o 

 

 



 

 

 



 

Question 11： 

如何使用 DISC 这个命令？ 

 

Answer： 

根据 ZEMAX 使用手册，关于 DISC 的描述如下： 

「经过校准的畸变（Distortion,calibrated.）该操作数计算整个场的校准畸变，并返回根据 f-theta

镜头时该操作数非常有用。」 

 

  

 



 

 

 

 

 

 



 

Question 12： 

请问一下，除了 Coupling Efficiency，ZEMAX 是否还有其它类似的分析功能，可以计算光

进入组件与离开组件后的损失(Loss)，或者是百分比？如何操作？ 

 

Answer： 

ZEMAX 中，没有特定分析损失或百分比的功能，但若您在 Sequential mode 下， Analysis

的功能中，您可以选用 Illumination/Illumination 2D surface 或 Image Analysis/Geometric Image 

Analysis (Settings 中选 Show False color)来帮助您分析。光线追迹到各组件表面的照明情形，依

您设的光线数来估算光线追迹到任何面时的光功率损失， 相同地，若您在 Non-sequential mode

下，就变成是观测 Detector 上的光功率照明。  

另外，Analysis/Universal Plot 可以用来绘出组件 deceter/tilt 后的耦合效率，是对应于 Fiber 

Coupling 的数值。 

 

 

 



 

Question 13： 

文件的 3D 图打不开，这个是什么原因？ 

 

Answer： 

您可以在 3D 图上点 Setting，进行如下设置， 

 

 

 

然后您就可以看到如下图，以前您看不到镜片是因为 OBJ 的厚度设置为 700mm，它远远

大于了镜片的总长。 

 



 

 

 

 



 

 

Question 14： 

Faraday cell 是将极化方向旋转 45 度，请问是否同样可以用 Jones matrix 来仿真? 

 

Answer： 

对于仅旋转 45 度的 Faraday cell，可以用 Jones matrix = (cos45 sin45 sin45 cos45) 来定义。 

 

 



 

 

Question 15： 

我尝试使用 Illumination/Illumination 2D surface 时，出现一个错误信息"CANNOT 

COMPUTE RELATIVE ILLUMINATION  ACCURATELY"，请问一下是什么问题？ 

 

Answer： 

原厂的说明为当您的系统像差过大或您的系统在出瞳上为焦散性质，会造成在成像面上的

照明分析会失效，关于 Relative Illumination 的定义可参考 Manual Chapter 7 ANALYSIS 

MENU/Illumination．测试的结果为若把 Settings 中的 Use Relative Illumination 的勾拿掉，则错

误信息就不会发生，且仍可看到相对的照明强度分布，这表示相对照明不依原本的定义所限制，

但值的差异与勾选 Use Relative Illumination 时，约仅差+,-0.001 左右，所以当您遇到此状况时

可以试着依此方式来观测您系统的相对照明分布。 

 

另外，ZEMAX 对于 Fiber Coupling Efficiency 的计算例子有两个标准文件可供您参考分别

为 Samples\Sequential\Interconnects\Ball coupling.ZMX 与 Samples\Physical Optics\Fiber 

Coupling.ZMX。 

 



 

 

Question 16： 

我在 Tracepro 中建立一个 LED 面发光源 (利用 SURFACE 建立角度对强度的关系)，我

想为这个特定的光源设计一个准直透镜, 不知是否能将这光源设罝到 ZEMAX 中？ 

 

Answer： 

可将光源汇入至 ZEMAX 中，但在序列性描光模式使用点光源。如果使用面光源，我们就

不能优化透镜。 

 



 

 

Question 17： 

使用误差分析看到 Change of  Focus 数值之后，为了验证准确性 ，我实际上把曲率作同

样的变化，然后看 System Data  -----  Focal Length 变化量与使用误差分析的变化量做比较，

结果有些微差异，请问我该怎么调整，才能使两者结果一致 !! 

 

Answer： 

ZEMAX 在进行公差分析时，缺省的情况是以 focus 作为 Compensator，所以会对系统的

Focus 位置作小的调整。在公差数据 Report 中，给出公差对系统 Back Focus 的影响，但这个数

据和 Focal Length 的变化值不是同一个值，所以它们不应该是一致的。 

 



 

 

Question 18： 

在 Zemax 中可否观察虚像? 

 

Answer： 

不能直接在 ZEMAX 中观察虚像，我们可以在真实世界看到虚像，是因为它会在眼晴的视

网膜上形成实像。或许可以在 ZEMAX 中增加成像系统，设计近轴透镜或一些人类眼睛的模型。

使用者可以应用 Geometric Image Analysis 或者其它的分析特征，将会有实像在成像系统的焦距

上。 

 



 

Question 19： 

Non-Sequential 模式下，检测面上是否可显示光源经过系统后的功率? 

 

Answer： 

检测面上除了显示 PEAK IRRADIANCE (WATTS/CM^2)，同时也显示 TOTAL POWER 

(WATTS)，如下图所示，故可以显示光源经过系统后的功率。 

    

 

 

 

 

 



 

 

Question 20： 

PX、 PY 是指光曈还是孔径光栏？ 

 

Answer： 

Px 和 Py 是归一化光曈座标，光曈是孔径光栏的成像。在物方中，光栏的成像是入曈，在

像方中，光栏的成像是出曈。如果渐晕因数被使用，光曈座标与其应用在新的（渐晕）光瞳，

不如应用在真实孔径的光栏。 

 



 

 

Question 21： 

在ZEMAX中，对于Fiber Coupling的例子档中，为何General中Aperture的Object Space 

NA 皆设为 0.2，而 Source fiber 和 Receiver fiber 皆设为 0.1？ 

 

Answer： 

General的NA为设罝系统的NA，即NAlens ，而Source fiber和Receiver fiber为设罝NAfiber ，

当 NAlens = 2NAfiber 时，原先默认高斯曲线仅能通过 1/e^2 的部分以内，但现在能通过超出这个

范围的部分，所以 Soure fiber 这时可输出超过 99.9%的能量，System Efficiency 约 0.99 左右，

而 Receiver fiber 的 NA 也应循 NAlens = 2NAfiber 时，Receiver Efficiency 会最大，而 Coupling 

Efficiency = System Efficiency * Receiver Efficiency。 

 



 

Question 22： 

在ZEMAX中，当在NSC模式下建构光学系统时，为何在更改雷射光源的能量( Power )后，

检测面上的能量值没变化? 

 

Answer： 

这是因为当您在NSC模式下建构光学系统时，在修改系统之后，需重新选择

Analysis->Detectors->Ray Trace/Detector Control的功能选项，然后在跳出的对话框中先点击

Clear Detectors钮，然后再点击Trace钮，以便对您修改的系统做重新追迹，以得到正确的变化

值。 

 

 

 



 

 

Question 23： 

当 ZEMAX 在各个不同的 FOV 计算光线交点误差，参考光线是什么？ 

 

Answer： 

这个答案要看你使用分析特征是什么，例如：光扇图的误差是参考主光线位置，有些分析

特征允许以主光线或中心光线作为参考。 

 



 

Question 24： 

如何在 ZEMAX 中，利用渐晕因数设罝渐晕？ 

 

Answer： 

有关渐晕因数的资料，可以参考使用手用第三章_Conventions and Definitions，渐晕因数是

指重新定义光瞳，仿真真实孔径的渐晕。如果你要将真实孔径应用在你的表面上（使用表面属

性」孔径」标签），在 ZEMAX 的 System/Field Data 视窗中，使用"Set Vig"键，ZEMAX 会在

接近真实孔径的影响下设罝渐晕因数。 

 

 

 

 



 

Question 25： 

Getpsf 取得的 psf 资料,似乎是采用 FFT 法，有无方法可得到 Huygens PSF？ 

 

Answer： 

目前 ZEMAX 的 Macros 仅提供 GETPSF，为针对 FFT PSF，Huygens PSF 的资料，仅能直

接透过 Analysis->PSF->Huygens PSF 的 Text 数值。 

 

 

 



 

 

 

第五章 

 

优化 
(Optimization) 



 

Question 1： 

已知透镜的孔径、厚度、曲率半径皆为固定，可是边缘厚度希望为零，现在我将 suf 设在

2 和 3 之间，target 设零，weight 设 100，但我发现我没有变量，不能优化，所以将厚度 0.8

设为变量去跑优化，没想到透镜厚度变更宽，MXEG 似乎没用。请问可以在不跑优化，也就

是不设罝 merit function 的情形下，将透镜边缘厚度改为零吗？ 

 

Answer： 

可以在不跑优化，也就是不设罝 merit function 的情形下，将透镜边缘厚度改为零：具体做

法是在 thickness 上按右键，用 solve 进行 Edge thickness 的设罝。或者您也可以试着使用

ETVA(edge thickness value)这个操作数。 

 

 

 

 



 

 

Question 2： 

如何使 Spot Diagram 中的 RMS&GEO 变小? 

 

Answer： 

在 Merit Function 中提供几个命令来 Follow 您 Default 的内容来做 Spot Size 的优化，分别

是 RSCE、RSCH、RSRE、RSRH，您需根据您所 Default 的参考依据来选择其中一个命令来使

用，如 Centriod、Chief Ray、Ring、Grid...etc。 

 

 



 

 

Question 3： 

在优化过程中，如何定义在不同 Pupil 的地方，其 Longitudinal Aberration 曲线可以依照

自己的意思跑吗？ 

 

Answer： 

当在使用 AXCL 和 LACL 等命令时，无法使用 Hx、Hy、Px、Py 来控制实际光线所走的

路径，此时会是一类型似默认的方法来达到优化，通常在 Pupil 的 0.8 处有交点，但若当您使

用 REAY 等命令时，您可在 Py 的地方给定 0~1 的值，即代表您希望在 Pupil 上的某个点所出射

的光线其 Longitudinal Aberration 会最小，即可在不同的 Pupil 处依您的意思去做优化。 

 

 



 

 

Question 4： 

如何使用 ZEMAX 的功能来分析镜头的 TV Distortion? 

 

Answer： 

关于TV Distortion的分析同样可使用ZEMAX的分析功能，分析功能在

Anaylsis->Miscellaneous->Field Curv/Dist和Grid Distortion。Field Curv/Dist图表的右半边为

Distortion的百分比曲线，其与Grid Distortion的图表为相对应的关系，即左图的百分比愈大时，

右图的方格将变形，而TV Distortion可能是因格子等比例放大时，虽然是失真，但由于等比例

放大，所以图像整体看起来还是没有变形的，此时在百分比曲线中，看起来是线性的。 

 

当然，这是要根据您所要设计的TV Distortion规格来对镜头做设计，您可在Merit Function

中，选择适当的优化操作数，如DISG、DIST、DIMX...etc，来做优化。在下图中，是以DISG

来定出当要求最大场点失真为10%时，然后对镜头优化出一线性关系，以上描述，为提供您在

做TV Distortion分析时的参考。操作分式则与您在使用Merit Function对镜头做优化时的方法相

同。 

 



 

    

 

 

 



 

Question 5： 

请问在ZEMAX中，有那些优化操作数可针对不同的非球面系数项下不同的权值? 

 

Answer： 

您可使用的优化操作数有 PMGT、 PMLT、PMVA、COGT、COLT、COVA…等，来针对

不同的非球面系数项下不同的权值，说明如下： 

  

PMGT：限制非球面系数项大于 Target 值，并可下权值。 

PMLT：限制非球面系数项小于 Target 值，并可下权值。 

PMVA：限制非球面系数项等于 Target 值，并可下权值。 

COGT：限制 Conic 系数项大于 Target 值，并可下权值。 

COLT：限制 Conic 系数项小于 Target 值，并可下权值。 

COVA：限制 Conic 系数项等于 Target 值，并可下权值。 

  

由于非球面系数项是定义在 LDE 的 Parameter 栏中，所以您会发现在选用 PMGT, PMLT, 

PMVA 时，会要求您键入非球面系数项所对应的 Parameter 栏，之后您即可针对不同的系数项

给定不同的权值以达到您的需求。 

 

 

 



 

 

Question 6： 

在ZEMAX中，如何利用Default Merit Function来同时对系统的两个表面做Spot Size最小

化的优化? 

 

Answer： 

当您建好 20 个表面系统的前 10 个表面，Default Merit Function 的参考选择 RMS、Spot 

Radius、Centroid 时，会以数个 TRAC 的操作数来默认您的 Merit Function，之后您可在 MFE

中的 Tools->Save，把您目前的 MF 存成 A.mf，现在您要做的一件事情，就是利用 Wordpad 或

记事本去开启 A.mf，然后把所有的"TRAC 0"置换成"TRAI 10"，因为 TRAI 可以控制中间面的

图像质量，然后再加上后面的 10 个表面，再重新 Default 一组 MF 来控成像面 (Sur 20) 的质量，

然后再把您刚刚所修改的 A.mf 中的所有"TRAI 10"贴到后来所 Defult 的 MF 之后，这样一来您

即可在 20 表面的系统中同时做两个表面的 Spot Size 最小化优化。 

 



 

Question 7： 

在ZEMAX中，要如何设罝系统为像方的远心(telecentric)系统? 

 

Answer： 

您可以使用优化操作数 RANG 来达成。藉由控制主光线在与成像面的夹角为 0 (Hx=0, 

Hy=1, Px=0, Py=0)，这意谓主光线(Chief Ray)会平行光轴，也就是出瞳的位置为无穷远。我们

可以运行优化来使系统达成远心系统，但前提是要有足够的变数 (曲率和厚度) 来达成远心条

件的设计。物方的远心系统可运用相同的技巧。 

 

我们以 ZEMAX 的例子 Cooke 40 degree field.zmx 来做示范： 

1. 将原先 Fixed 的 Semi-Diameter 栏改为 Automatic。 

 

 

 

2. 设罝优化操作数 RANG 以及 Default Merit Function 为 RMS、Spot Radius、Centroid。 

 

 



 

 

 

3D Layout 图－优化前： 

 



 

 

3D Layout 图－优化后： 

 

 



 

 

Question 8： 

设计一个透镜，LED发出的光通过此透镜之后会变成平行光源。目前遇到的问题是： 

 在surf 3遇到了全反射无法做优化 

 不知道用哪些Merit Function Operands可以有效降低优化函数值（我尝试过RANG和REAY

都没有得到很好的效果）? 

 

Answer： 

这是因为边缘光线超出镜片之外且有部分指定的光线发生全反射，建议您可以改进的方式

如下： 

1. 先不要将 Surf 2 和 Surf 3 的 Semi-Diameter 设为固定 (Fixed)，让所有的光线能通过镜片，

等优化完后再去决定您需要的透镜半高。 

2. 因为出现"Error 917:Error in target 1. TIR at surface 3!"，表示 Py=1 时的光线会全反射，所以

您可先试着对Py=0.8时做优化(Target值可依据目前的Value来决定)，之后可能会出现"Error 

917:Error in target 17. TIR at surface 3!"，表示这个默认的操作数所指定的 Px 在计算时同样

会造成全反射，故可先将其删掉。 

3. 在完成上述步骤后，您应该可以继续您的优化工作，此时还要注意，您 REAY 的 Target=3

有问题，应该是小于透镜半高才正确，故应是小于 1.5 左右的值。(如果您的半高如上所述

不设为固定，则它的值约为 1.6 左右)  

 

 



 

 

Question 9： 

在 ZEMAX 中，对于 H 与 P 的定义，其意义为何？ 

 

Answer： 

Merit Function 的设罝基本上可以依照个人需求及习惯设罝，H 与 P 是 Field 与 Pupil 的归

一化设罝，因为各种情形下的 Field 与 Pupil 会有所不同，所以利用归一化（0～1）来避免这个

麻烦。例如设罝 RANG 是与 Z 轴的角度来计算，设罝 PY＝1 时（也就是最外面的光线）与 Z

轴的角度为 0，PY=0.5 时（一半的地方）角度也为 0，选择成像面为分析的表面，则光线在我

的成像面上将会是平行光。 

 



 

Question 10： 

如何缩短优化的时间?若设计一个单一波长的非球面 Objective Lens，遇到最大的问题在于

Spherical Aberration。若将 Lens 的两个面设罝为 Even Asphere，并将 Radius、Conic、4th~10th

设罝为变数，则在使用 ZERN 作为优化运算参数，并分别对 4，9，16 项去作运算，需要花上

数十分钟的时间，才能达到 PV 值=0.0004 波长的要求。是否搭配 RSCH 及 MTFT 可加速运算

时间? 或着是否须再设罝其它参数? 

 

Answer： 

加快优化速度仅能从硬体着手，即CPU速度>1GHz以上，或使用多CPU的方式，而ZEMAX

提供多 CPU 的方式如下图所示。  

 

 

 



 

Question 11： 

在 TracePro 中自己建立的面光源模型有可能转入 ZEMAX 中吗? 

   

 

Answer： 

可将光源汇入至 ZEMAX 中，但在序列性描光模式只可使用理想光源。如果使用面光源，

必须切换至非序列描光模式，因此就不能优化透镜。 

 

 

 

 

 



 

 

Question 12： 

在 Merit Function 里，如何控制 Longitudinal Aberration ? 

 

Answer： 

"Longitudinal Aberration"是在 Analysis 中的图表分析，其所指的是"Longitudinal Chromatic 

Aberration"，在 ZEMAX 中，有两个优化命令可以分别消除 Longitudinal Chromatic Aberration

和 Lateral Chromatic Aberration，各为 AXCL 和 LACL，您必须在 Wave1 和 Wave2 键入您所设

罝的波长之两极端的值，例如：您使用的波长 1、2、3 分别为 R、G、B 的三个波长，则 Wave1

键入"1"和 Wave2 键入"3"，Target 键入"0"，Weight 键入"10"，则可有效消除红光与蓝光在光轴

上之 Chromatic Aberration，所以您可在优化后再次比较 Analysis 中的图表分析，将可发现有明

显的改善。 

 



 

 

Question 13： 

请问「Merit Function Editor」和「Multi－Configuration Editor」如何使用？ 

 

Answer： 

“Merit Function Editor”是使用一些操作数或命令来控制图像质量，如 REAY，EFFL，MTFA。

Multi－Configuration Editor 通常用在变焦系统、分光等光学系统中，它可帮助用户对 Lens Data 

Editors 中的某一资料设置多个状态，如曲率半径、厚度、光学材料等，也可以对 System 菜单

下的 General、Field、Wavelength 的参数进行设置。 

 



 

Question 14： 

可否在 ZEMAX 中观察追迹光线的平行度？我们设计了一个系统，光线有点发散，想知

道它发散的程度。 

 

Answer： 

可以在 merit function 中添加 ISNA 这个操作数，通过其计算像方的数值孔径的值，再换算

成出射光线的角度，就可以知道它的发散程度了。其实还有一种方法可以直接看光线在各个面

上的角度。方法是：Analysis->calculation->ray trace(Ctrl + Y)，显示的资料就是光线在各个面上

的 Direct cosine 或 Tangent 值。 

 

 

 

 



 

 

Question 15： 

因为 RMS 优化的 Default Merit Function 似乎只有针对 Image 面，而 A+B 系统中我只想

先针对 A 系统的最后一面做 RMS 优化，所以两者 Merit Function 似乎不能同时写在一起，或

是有什么命令可以针对某特定面做RMS优化？还是用A程序做完RMS优化后，再写一个A+B

程序将 A 跑完后把所需的值带入 A+B 程序，A+B 系统之定义如下： 

例如在系统中有A和B两种优化情况，A是针对RMS优化，A做完后所得到最佳参数继续在

带入下去给后段B去做成像的优化，所以A我有一个Default Merit Function A.mf，B有一个

Default Merit Function B.mf，假如我把两个写在一起 A+B.mf，会有彼此Weight 设罝的混淆，

因为两者是先做完A优化后再做B，是各自独立的，所以我才想是否可以用Marco，例如在做A

优化时Load A.mf，做完优化后取到我想要的参数，然后再Load B.mf去做我后段的优化，现阶

段我是前后开两个Zemax档，先做完A系统的优化后，把A优化后的值记起来丢入另一个A+B

系统的档做优化，要分两个阶段去做，所以才想请问是否可以在Marco中使用Load的方式去运

行。 

 

Answer： 

假设您的 A 与 B 是指同一个系统， 您或许可以利用 Multi-Configuration 的方式来对 A 与

B 同时做优化，并在 Merit Function Editor 选择 Default Merit Function，即可同时对个别结构

Default 出一组 RMS 的优化，且在 Multi-Configuration Editor 中去个别指定 A 与 B 的可优化参

数，如各个表面的厚度或曲率...等，然后再去做优化，找出 A 或 B 的最佳值。或者，您可在 A

优化完之后另存新档 B，然后再开启 B 并加入欲优化的参数再去做优化。至于您最后一个问题，

似乎是种找解的方法，其实，如果您觉得这样的方式可以找出您想得到的解，且有不错的效果，

则您可使用这样的方法。 

 

ZEMAX 已提供局部性优化 Optimization...和全局性优化 Global Search... & Hammer 



 

 

Optimization...， 原厂建议过一种有效的方法，为点击 Hammer Optimization 后，先以 Auto DLS

钮做局部找解，然后再以 Hammer 钮做全局找解。 

 



 

 

Question 16： 

我们想设计一个透镜，LED 发出的光通过此透镜之后会变成平行光源，请问为什么在 sur3

遇到了全反射无法做优化？ 

 

Answer： 

您的结构设置有点问题，全反射的产生是因为物面(OBJ)后面的材料被设罝为玻璃。 

 



 

 

Question 17： 

不知道用那些 Merit function 可以降低优化函数。（我尝试过 RANG 和 REAY 都没有得到

很好的效果。） 

 

Answer： 

优化函数的数值是否能有效降低，会和您所下的限制、可变动之变数项、表面型态以及权

值等有关，没有绝对的方法，而您在用 REAY 这类的优化命令时，应该不会只对其中一项做设

罝，而可能在 Py = 1、0.8、0.5、0.3...等地方的光线进行控制，所以需要同时对它们做优化，

并分配不同的权值。也许还可使用「RAID」或「RAIN」的命令并指定为第最后一个表面(IMA

面)来做优化，来达成所需要的性能。 

 



 

 

Question 18： 

如何在透镜组的焦距不变的条件下，透过更改和优化其中的某些透镜曲率使透镜组的畸变

量变小，如达到万分之几的情况。在Zemax中应该如何操作？ 

 

Answer： 

以下是针对畸变的优化提供一些参考建议： 

1. 一般要控制畸变用 DIMX，DIST 已经够了。 

2. 如果对畸变要求这么高，可能要自己建立一些操作数，可以考虑下面的操作数：REAY，

PARY。 

 

 



 

Question 19： 

光线偏轴射出时，如何让光线以一个角度射出？ 

 

Answer： 

您可以在 Merit Function Editor 中使用 RAED、RAEN、RAID、RAIN、RANG 等操作数来

控制任意面的光线角度。如果您不知道怎么使用这些操作数，您可以点击 MFE 的 Help 查询。 

 

 

 

 



 

 

 

第六章 

 

公差 
(Tolerancing) 



 
Question 1： 

在分析一非球面广角镜头时，在进行公差分析会产生如下所示的错误信息，所有设罝皆使

用默认值，请问为什么会这样呢？ 

 

 

Answer： 

您所提供的镜头，在第一个表面上产生了全反射（如下图所示，当您设罝 Default Merit 

Function 时就会出现此错误信息），因为公差分析时 ZEMAX 无法计算系统的 MF Value，所以

无法进行公差分析。 

 

你可以使用 Field Data 视窗内的「Set Vig」来排除产生全反射的光线。 

 

Question 2： 

采样设为 1 的话 公差分析是否会与采样高时所跑的公差分析会有落差。 

 



 
 

 

Answer： 

采样被用来设置在计算公差评价函数时要追迹多少条光线。采样越高，追迹的光线越多，

得到的结果越好，但运行的时间也将增加。 

 

 
 

 



 

 

 



 

 

 

第七章 

 

工具 
(Tools) 



 

Question 1： 

在ZEMAX中，为什么在选用Tools->Export Data->Export IGES/STEP/SAT Solid时不能成

功导出?  

 

Answer： 

这是因为此项功能还在逐渐发展阶段，而对于大部分的案例皆能成功导出，所以若您目前

的版本不能成功导出，请试着到ZEMAX的网站www.zemax.com/updates/index.html下载最新版

本，并运行版本刷新。 

 

 

 



 

 

 

 



 

 

Question 2： 

请问一下,若欲用 ZEMAX 仿真 850nm 雷射在多模光纤传递,请问该怎么做?是可以像一般

仿真单模一样吗?还是有什么特别的设计?因为有听说 ZEMAX 是设计给单模光纤用? 

 

Answer： 

1. 您可以分析 Spot Diagram 的 Size 在经过 Coupling Lens 后，是否小于 Receiving Fiber 的 Core，

并分析有多少个%可耦合能量到 Fiber。 

2. 单模光纤的分析在 ZEMAX 中是使用 Analysis->Calculations->Fiber Coupling Efficiency，它

是假设在 Coupling Lens 的前后两端放置单模光纤并键入 NA 值，则可利用能量重迭积分的

方式来计算耦光效率。所以第 1 项使用 Spot Diagram 的方式将不适用。 

3. 通常 ZEMAX 用于 Transceiver 主要是针对 Coupling Lens 做设计，可设计 Ball Lens, Gradient 

Lens, Asphere Lens...etc，并分析所设计 Lens 对 Fiber 的耦合效率。 

4. 所以 ZEMAX 是可应用于单模和多模光纤的耦合分析，唯一限制是"Lens< nm"和"当您要分

析光在光纤中的模式分布"，此时则需选用 Optiwave 的光通讯相关软件。 

 

 

 



 

 

Question 3： 

GENIUS.AGF,此塑胶材料是否为新版 ZEMAX 所 UPDATA 提供？ 

 

Answer： 

在 ZEMAX 的最新版本 January 19, 2004 版中，并没有 GENIUS.AGF。原厂有说明，如果

您知道这是那一家制造商的塑胶材料，可提供原厂供制造商的材料数据或接洽资讯，只要

ZEMAX 取得资料，即会把它放入之后的新版本中。 

 



 

Question 4： 

请问一下，ZEMAX 如何设罝背景周围的折射系数？ 

 

Answer： 

您只需要像填入玻璃材料的型号一样，在 Glass 栏中填入您的周围材料，例如您可以在

Tools->Catalogs->Glass Catalogs 中的 MISC.AGF 数据库里找到 SEAWATER (海水), WATER 

(水),  VACUUM (真空)...等常见的背景周围折射率。 

 

 

 



 

 

 

第八章 

 

多重组态 
(Muti-Configurations) 



 

Question 1： 

我的焦平面上的像是由 multi-configuration 组成的 , 请问我该如何对此类的仿真结果作

分析 ? 因为我的像是结合多个 configuration 而成的。 

 

Answer： 

您可参考 ZEMAX 例子 Samples->Zoom systems->Scanning mirror.zmx。在此例子中，用了

2 个常用的图表分析功能： 

 

1. Layout: 同时显示不同组态的光路在焦平面的成像位置是否为您所需要的。 

 

2. Configuration Matrix Spot Diagram: 比较各组态的光斑图在焦平面上的聚焦好坏。 

 



 

 

3. 您会发现，如 1)和 2)的方式可能无法明确读值，所以最常用的方式为使用热键「Ctrl+A」

来即时切换各种分析图表。以下以 Spot Diagram 为例。 

Ex： 

 

 



 

 

 

由于您所描述的问题较为广泛，故仅建议您较常使用的方式。通常您需视您规格的要求选用适

 



 

 

当的分析图表做分析。 

 



 

Question 2： 

在 ZEMAX 中，要如何才能优化波长(Wavelengths)、视角(Field)或系统孔径(System 

Aperture)的值? 

 

Answer： 

您需藉由多重组态编辑栏(Multi-Configuration Editor, MCE)中的操作数来达成，例如，您可

以在单一组态中，使用操作数WAVE、YFIE、APER，并将它们设罝变数即可。 

 

 

 



 

 

 

第九章 

 

解 
(Solves) 



 

Question 1： 

如何使用 ZEMAX 来快速的找到焦点？ 

 

Answer： 

可以使用以下两种方式： 

 

1. 在最后一个 Surface 的 Thickness 点右键，然后选择 Marginal Ray Height，按下 Ok 钮。 

 

 

2. 选 Tools->Miscellaneous->Quick Focus(Shift + Ctrl + Q)。 

 

 



 

 

 

第十章 

 

物理光学 
(POP) 



 

Question 1： 

PSF 计算出来的像平面上的光强度和 POP 计算的 Total Irradiance 为什么差别很大？ 

 

Answer： 

PSF 和 Total Irradiance 的定义不同，它们的运算法则运算式是完全不同的，所以图表的形

状是完全不同的。像平面上的全部光能量是 PSF 的积分，如果点光源的光强度增加，则像平面

上的光能量也会等比例增加。在计算 PSF 时，光源是点光源，其计算的平面是垂直于入射主光

线的；而计算 Total Irradiance 时，光源是高斯光束，是计算像面上的值。因此，它们的数值不

好直接比较。 

 

 



 

 

 

 



 

 

Question 2： 

如果我在多重组态编辑器中使用CRVT、THIC、SDIA操作数，而解的类型是”pick up”，

但在LDE中，半径、厚度、半口径解的类型为固定。出现错误的信息为Error 

973"Multi-configuration parameters cannot use this solve dialog. Change the status of this 

parameter on the Multi-configuration editor!"当解对话框被叫唤（例如：厚度，双击透镜资料

编辑器中的厚度单格），此值被多重组态操作数(multi-configuration operand)控制，所以解对

话框不被使用，请问是发生什么问题？ 

 

Answer： 

在多重组态编辑器(MCE) 的参数，任何在参数上的解(solve)都会被加入在透镜资料编辑器

（LDE）中，不可能在透镜资料编辑器（LDE）中的参数上键入任何的解，LDE 变成只「显示」

资料，因为 MCE 控制各个组态的值。"Error 973"是告诉你 LDE 的值被 MCE 控制，你必须在

MCE 为这个值指派解。 

 



 

 

Question 3： 

在ZEMAX中，热传期间玻璃的折射率是固定的，有什么方法可以解决呢？ 

 

Answer： 

ZEMAX 改变玻璃库的折射率，像温度的函数一样，有可能和热分析同时间被玻璃取代。

在多重组态编辑器中，第一个组态，你可以在 GLSS 操作数放玻璃代替解，在其它组态中，你

可以使用 thermal pick-up.。 

 



 

Question 4： 

当我在多重组态编辑器（Multi-Configuration Editor）使用工具菜单里的自动热分析（Auto 

Thermal）进行热分析。键入THIC操作数后，想设罝透镜之间是空气，但是ZEMAX使用空气

中的玻璃热膨胀系数，ZEMAX可以直接使用空气吗？如何设罝？ 

 

Answer： 

进行热分析时，如果材料没有在玻璃库中（Glass Catalogs）， ZEMAX 直接使用镜头资料

编辑器(LDE)TCE 欗位的值，在默认时，此栏为零，所以 TCE 空气间隙为零。当透镜改变形状，

两透镜之间的厚度将会改变。因为 TCE 值为零，边缘厚度保持为常数，要避免两透镜之间的

厚度没改变，可以移除 THIC 操作数（operand）。可以参考 Manual。 

 

 

 



 

 

 

 



 

Question 5： 

在 POP 功能中，Fiber Data 项目中的 Fiber Type 是用来设罝 Fiber 的 Mode 吗? 

 

Answer： 

是的。 

1. 您可尝试着以 ZEMAX 所提供的例子来分析这个问题，file 在 

     ZEMAX\Samples\Physical Optics\Fiber Coupling.zmx 

 

 

 

2. Fiber Data\Fiber Type 可选择的 mode 中，Gaussian Angle 和 Gaussian Waist 

     是可透过下式来转换的 

 



 

 

其中 ω0 为 waist 的直径，您可藉由 POP 图来大致看出，θ为半角，故在 Samples 的图表分析中，

若 fiber 可接收的 waist 直径为 0.008mm 时（相当 core 的大小约为 0.008mm 时），其耦合效率最

高，经由上式换算结果，若要设罝 Fiber Type 为 Gaussian Angle 时，则 angle 值约要设为 2.28。
，

若要换算为 NA 值，则 fiber 的 NA=sin2.28。
≒0.04。 

 

 



 

 

 



 

 

 

第十一章 

 

宏 
(Macro) 



 

 

Question 1： 

假如一个程序里想包含两个 Marco 档，也就是说 Marco1 会用到 Marco2 和 Marco3，要

用何种命令把他们连结起来?有点像大程序中包含两个独立的程序。 

 

Answer： 

您的问题是有关于 Macro 呼叫 Macro 的问题，在 ZEMAX 中目前并没有命令来完成这样的

工作，我询问了原厂，如果您能详细的描述或解释为何您要使用这样的方式来用子程序来完成

您的工作，即使用 GOSUB, SUB, RETURN, and END 的命令来定义和呼叫子程序 (您另一个

Macro 所要做的功能) ，关于这个命令的详细描述，您可参考手册 Chapter 22 ZEMAX 

PROGRAMMING LANGUAGE...ZPL keywords...GOSUB, SUB, RETURN, and END。 

 

 



 

 

 

第十二章 

 

安装 
(Installation) 



 

Question 1： 

在ZEMAX中，为何当安装所下载的刷新版本后，会需要重新键入License Code? 

 

Answer： 

当您在下载刷新版本的同时，请同时下载 lc.dat 的文件，并在运行完刷新版本后，请复制

您刚才所下载的 lc.dat，贴到 ZEMAX 的目录底下，将原本的 lc.dat 取代掉，即可正常运行刷新

版本。 

 

 

 

 



 

 

 

第十三章 

 

文件格式 
(File Format) 



 

Question 1： 

听说像OSLO等软件，可在运行系统下点击资料夹中的 ICON，直接开启文件。 而ZEMAX

似乎必须先启动该软件，才能选择要开启的文件。请问有无改善方法? 

 

Answer： 

只要依照步骤做设罝，此后即可直接点击 ZEMAX 文件开启。 

 

 



 

 

 

 

 



 

 

 

 

 



 

 

Question 2： 

当我设计一 DSC LENS 后，将 2D Layout 转档成 Autocad 的*.DXF 档，使用 AutoCad 开

启*.DXF 档时，我的非球面就会产生错误的图面，原本的 Surface 会变成一个很平滑的曲线，

跟在 ZEMZX 内 2D Layout 的图不同，请问是何情况? 

因为转档的问题不是只有这一个文件会发生而已，一个公司不可能只有开发一个案子，如

果说这 Bug 一直发生，那么是否每一个，设计都必须要请原厂协助修正呢? 

 

Answer： 

这问题是因为软件在转档时发生bug，您可将转档发生问题的曲面寄给原厂，请原厂协助

修改转档后的文件。 

 

我会将您的建议以及文件传给原厂，但因转档问题不只涉及ZEMAX本身，还与AutoCad

的文件格式设罝有关，可能无法很快解决此问题。 

 



 

Question 3： 

DDE 的文件编辑，请问是否必须购置其它程序,才能将.C 的文件转成 DLL 格式? 是否亦

须此软件才能运行? 

 

Answer： 

是的，您需要有 VC++或 Borland C++的程序才能将.C 的文件转成.DLL 的格式。若您只是

要进行观看或编辑，仅需用记事本(Notepad)即可开启。C++是用来转.C 的文件成.DLL 的格式，

只要将.DLL 的文件放到 ZEMAX 的 DLL 文件夹中，ZEMAX 即可使用该文件。 

 

 

 



 

 

 

第十四章 

 

错误信息 
(Error Message) 



 

Question 1： 

在 ZEMAX 中，若出现 ERROR 58: Key driver not be installed 的信息时该如何处理？ 

 

Answer： 

您需至 CD 里 DRIVERS 目录下安装适合您计算机运行系统的 Driver，即可解决。 

 

 

 



 

Question 2： 

ZEMAX－在 ZEMAX 中，当使用 MTF 的分析功能时，若图表上出现 ERROR 921：

SAMPLING TOO LOW, DATA INACCURATE!的信息时，是什么原因造成的呢? 

 

Answer： 

这是因为您所设罝的采样率太低，您只要把采样率调高即可。如下图所示： 

 

 

 



 

Question 3： 

 在ZEMAX中，为何使用NSC with ports来建构光学系统时，会出现"Non-sequential 

surfaces must be followed by a standard surface type."的错误信息?   

 

Answer： 

 这是因为当您以 NSC with ports 来建构您的光学系统时，除了建构 NSC 的表面之外，还要

多插入一个 standard 的表面在 NSC 所在的表面之后，有了这两个表面才能完整的描述 NSC 的

边界，即键入 port 和输出 port。 

 

25 

50 
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Question 4： 

为何在ZEMAX中使用Relative Illumination Plot时，图表上会出现 " CANNOT 

COMPUTE RELATIVE ILLUMINATION " 的错误信息? 

Answer： 

这是因为您的系统设罝有违反Relative Illumination的定义，而关于定义部分您得查看

ZEMAX手册Chapter 7 ANALYSIS MENU/Illumination/Relative Illumination，当然根据手册的内

容描述如下： 

For systems with very high amounts of vignetting, or for systems with non-linear cosine space 

aberrations that would violate the assumptions of the computation, the relative illumination cannot be 

calculated, and an error message will be displayed. 

您的系统使用了许多渐晕 ( vignettig ) 或像差过大时将违反定义，所以您可能要考虑修改您的

系统！  

 



 

Question 5： 

下图是在安装 ZEMAX 时出现的错误信息，请问为什么出现这种问题呢？问题出在

KeyPro 的还是 PC。 

 

Answer： 

我想如果您只在一台计算机使用这个 KeyPro 的话，这个问题是不会常出现的。下面我给

您几项建议： 

1. 您到ZEMAX网址 http://www.zemax.com/updates/index.html下载Sentinel_700.exe并安装之。 

2. 在其它计算机上测试这个 KeyPro。 

key 寄回讯技，我们将测试 KeyPro。 如果你尝试了以上，问题还存在，请您把

 

Question 6： 

装完 ZEMAX 最新版本后，软件会无法使用呢? 为什么安

 

http://www.zemax.com/updates/index.html


 

 

 

Answer： 

为您下载最新版本的时候，步骤有误，您需按照以下步骤来运行安装： 

1. 

这是因

上ZEMAX网页http://www.zemax.com/updates/index.html。 

2. 请在 lc.dat、ZEMAX_Date.exe，按右键/另存新档，将此两个档存到您的硬盘中。 

c.dat 覆

AX。 

3. 先运行 ZEMAX_Date.exe，安装完成后，再将 lc.dat 贴到 C://ZEMAX/，将原本的 l

盖掉即可。 

4. 重新开启 ZEM

 

 

 

 


